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An Introduction to HFSS™

Conventions Used in this Guide

Please take a moment to review how instructions and other useful information are presented in
this documentation.

* Procedures are presented as numbered lists. A single bullet indicates that the procedure
has only one step.

« Bold type is used for the following:

o Keyboard entries that should be typed in their entirety exactly as shown. For
example, “copy file1” means you must type the word copy, then type a space, and
then type file1.

° On-screen prompts and messages, names of options and text boxes, and menu
commands. Menu commands are often separated by greater than signs (>). For
example, “click HFSS > Excitations > Assign > Wave Port.”

o Labeled keys on the computer keyboard. For example, “Press Enter’ means to
press the key labeled Enter.

« ltalic type is used for the following:
o Emphasis.
° The titles of publications.
o Keyboard entries when a name or a variable must be typed in place of the words in

italics. For example, “copy filename” means you must type the word copy, then
type a space, and then type the name of the file.

» The plus sign (+) is used between keyboard keys to indicate that you should press the
keys at the same time. For example, “Press Shift+F1” means to press the Shift key and,
while holding it down, press the F1 key also. You should always depress the modifier key
or keys first (for example, Shift, Ctrl, Alt, or Ctrl+Shift), continue to hold it/them down, and
then press the last key in the instruction.

Accessing Commands: Ribbons, menu bars, and shortcut menus are three methods that can
be used to see what commands are available in the application.

* The Ribbon occupies the rectangular area at the top of the application window and
contains multiple tabs. Each tab has relevant commands that are organized, grouped, and
labeled. An example of a typical user interaction is as follows:

"Click Draw > Line"

@ |t
& L.
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This instruction means that you should click the Line command on the Draw ribbon tab.
An image of the command icon, or a partial view of the ribbon, is often included with the
instruction.

e The menu bar (located above the ribbon) is a group of the main commands of an
application arranged by category such File, Edit, View, Project, etc. An example of a
typical user interaction is as follows:

"On the File menu, click the Open Examples command" means you can click the File
menu and then click Open Examples to launch the dialog box.

* Another alternative is to use the shortcut menu that appears when you click the right-
mouse button. An example of a typical user interaction is as follows:

“Right-click and select Assign Excitation> Wave Port” means when you click the right-
mouse button with an object face selected, you can execute the excitation commands
from the shortcut menu (and the corresponding sub-menus).

Getting Help: Ansys Technical Support

For information about Ansys Technical Support, go to the Ansys corporate Support website,
http://www.ansys.com/Support. You can also contact your Ansys account manager in order to
obtain this information.

All Ansys software files are ASCII text and can be sent conveniently by e-mail. When reporting
difficulties, it is extremely helpful to include very specific information about what steps were
taken or what stages the simulation reached, including software files as applicable. This allows
more rapid and effective debugging.

Help Menu
To access help from the Help menu, click Help and select from the menu:
* [product name] Help - opens the contents of the help. This help includes the help for the
product and its Getting Started Guides.

* [product name] Scripting Help - opens the contents of the Scripting Guide.

+ [product name] Getting Started Guides - opens a topic that contains links to Getting
Started Guides in the help system.

Context-Sensitive Help

To access help from the user interface, press F1. The help specific to the active product (design
type) opens.

You can press F1 while the cursor is pointing at a menu command or while a particular dialog
box or dialog box tab is open. In this case, the help page associated with the command or open
dialog box is displayed automatically.
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1 - Fundamentals of HFSS

"Overview of High Frequency Structure Simulator (HFSS)" on the next page
"Mathematical Method Used in HFSS" on page 1-4

"Adaptive Solution Process and its Importance to HFSS" on page 1-8
"Computational Volume and its Parts" on page 1-11

"Solution Types" on page 1-12

"Network Analysis and Composite Excitations" on page 1-16
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Overview of High Frequency Structure Simulator (HFSS)
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Figure 1-1 HFSS Designs and Electric Field Plots
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High Frequency Structure Simulator (HFSS) is a 3D electromagnetic (EM) simulation tool used
to design a broad range of high frequency products such as antennas, filters, and IC packages.
HFSS has advanced 3D electromagnetic field solvers based on finite elements and other
integral equation methods supported by high performance computing technology that enable
engineers to perform rapid and accurate design of high-frequency and high speed electronic
components.

The following figure contains results showing electric field plots on some sample designs
created and solved in HFSS. These designs include:

» coaxial resonator model using Eigenmode solver

« driven terminal design of a complex package

« driven modal design of a coax-fed helical antenna with a dielectric support on a finite
ground plane

* awaveguide combiner used to combine output power of two 20 GHz solid state power
amplifiers

Fundamentals of HFSS 1-3
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] coaxial_resonator - HFSSDesignl - .. o|[@] =] | ] package - HFSSDesignl - Modeler \Er-
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Figure 1-2 Sample HFSS designs with results

Mathematical Method Used in HFSS

The numerical technique used in HFSS™ is the Finite Element Method (FEM). In this method a
structure is subdivided into many small subsections called finite elements. In HFSS these finite
elements are in the form of tetrahedra. The entire collection of tetrahedra constitutes the finite
element mesh. A solution is found for the fields within these tetrahedra. These fields are
interrelated so that Maxwell's Equations are satisfied across inter-element boundaries yielding a
field solution for the entire original structure. Once the field solution is found, the generalized S-
matrix solution is determined. The following figure shows the geometry, mesh, field results, and
the S-matrix results of a bandpass cavity filter in HFSS.

Fundamentals of HFSS 1-4
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3D Model of a Coaxial Fikker M eshed Structure
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Figure 1-3 A sample HFSS model with mesh plot and results

Subject to excitation and boundary conditions, HFSS solves for the electric field E using the
following equation:

Vx (%r V x E) —k} & E = —jw uojsowce (1)

Fundamentals of HFSS 1-5
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where
2 W
kO == 0_2

€ Ky are the relative permittivity and permeability respectively and c is the speed of light in
vacuum.

Note '_I\sau,rce is used to represent any source.
HFSS calculates the magnetic field H using the following equation:

H=L1VxE (2)

The remaining electromagnetic quantities are derived using the constitutive relations.

From the quantities used in equations (1) and (2) it’s clear that a problem in HFSS is considered
in terms of electric and magnetic fields rather than in terms of voltages and currents.
Consequently, it is important that an HFSS simulation includes a volume within which electric
and magnetic fields exist. These volumes generally comprise of dielectrics and conductors
(including air, that surround the conductors).

HFSS derives a finite element matrix using the field equations to calculate the fields and S-
matrix associated with a structure excited with ports.

The procedure to solve the problem in HFSS can be briefly described as follows:

1. A geometric structure is represented by a finite element mesh using tetrahedral elements.

2. Testing functions Wn are defined for each tetrahedron, resulting in thousands of basis
functions.

3. The field equation is multiplied by Wn and integrated over the solution volume

This procedure yields thousands of equations for n=1,2,...,N.

f(Wn.Vx (”i Vx E) —ko2erWn.E)d/V=0 3)

After manipulating these N equations and using Green’s theorem and the divergence theorem
the following equation is obtained:

f[(Van). (ui V x E) - kozerWn.E] dV = [boundarytermsdS (3a)
" S

v

forn=1,2,...,N writing,
E=Y wW,, n=12..,M (4)

rewrites (3a) as,

Fundamentals of HFSS 1-6
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3 Xan f[(Van).(”lr Vx Wm) — ko2 W,. Wn] av = Sfboundarytermsds (5)

forn=1,2,....N

Equation (5) then has the form

YtmApm =bp,n=1,2,..N (6)
or
Az =) )

In this matrix equation, A is a known NxN matrix that includes any applied boundary condition
terms, while b contains the port excitations, voltage and current sources and incident waves.

E can be calculated when equation (7) is solved for x.

In HFSS the shape functions or testing functions Wn (appearing in the above equations) are
vectors. They are curl conform which essentially means that the tangential continuity of the E
field is maintained. They are also hierarchical with variable polynomial order. In other words the
higher order polynomial shape functions are appended to the lower order polynomial shape
functions. Different orders of basis functions employ different interpolation schemes for
interpolating field values from the nodal values. This property is imperative for the iterative
solver.

Vertex i

Tangential and Normal

Figure 1-4 Hierarchical vector basis functions

The field solution process utilized by HFSS is iterative. In other words, HFSS uses the above
process repeatedly by refining the mesh in an intelligent manner, until the correct field solution is
found. This repetitive process is known as the adaptive mesh refinement process that yields
highly accurate results.

Fundamentals of HFSS 1-7
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For example, consider a simple waveguide structure. Initially, HFSS computes the modes on the
cross-section of the waveguide. These modes serve as port excitations for the waveguide.
HFSS uses a two dimensional FEM solver to calculate these modes. This initial calculation is
referred to as the “port solution.” Once the port modes are known, they are used to specify the b
matrix.

After the right hand side of equation 7 is determined, HFSS computes the full three-dimensional
electromagnetic fields within the solution volume using the adaptive solution process. When the
final fields are calculated, HFSS derives the generalized S- matrix for the entire model.

Note: The gamma results and characteristic wave impedance Zo that HFSS displays in a matrix
data for a given simulation are essentially the transmission line properties of the modes of the
wave port.

Adaptive Solution Process and its Importance to HFSS

HFSS uses the automatic adaptive mesh refinement process to solve an EM problem. Automatic
adaptive mesh refinement is a critical part of the overall solution process and the key to
producing accurate results. This meshing technique helps you focus on setting up your design
efficiently rather than spending time in determining and creating the best mesh. To set up the
design, you need only to create the geometry and specify material properties, boundary
conditions, excitations, and the solution frequency.

Note: For more information about how to set up a design, see "Modeling Practice in HFSS" on
page 5-4.

In the adaptive mesh refinement process, the mesh is refined iteratively and is localized to
regions where the electric field solution error is high. This iterative refinement technique
increases the solution’s accuracy with each adaptive solution. The refinement process
continues until HFSS converges to an accurate solution. Convergence is determined by
monitoring a parameter from one adaptive pass to the next. The most common convergence
criterion is to ensure that the difference in the S-parameter value between two consecutive
solves is less than the specified magnitude.

Fundamentals of HFSS 1-8
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Create initial
mesh

Solve fields using
finite element method

Calculate local
solution error

Max DeltaS
< Goal

Calculate broadband
S-parameters (if desired)

Figure 1-5 Simplified Flow Chart of Adaptive Refinement
The adaptive process can be summarized as follows:

1. HFSS generates an initial geometrically conformal mesh.

2. Using the initial mesh, HFSS computes the electromagnetic fields that exist inside the
structure when it is excited at the solution frequency.

3. Based on the current finite element solution, HFSS determines the regions of the problem
domain where the exact solution has a high degree of error. A predefined percentage of
tetrahedra in these regions is refined. The mesh is refined by creating a number of smaller
tetrahedra that replace the original larger element.

4. HFSS generates another solution using the refined mesh.

5. HFSS recomputes the error, and the iterative process (solve -> error analysis -> refine)
occurs until the convergence criteria are satisfied or the requested number of adaptive
passes is completed.

Fundamentals of HFSS 1-9
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Note: If a frequency sweep is being performed, HFSS solves the problem at other frequency
points without further refining the mesh.

The above process creates an appropriate mesh for any arbitrary HFSS simulation ensuring an
accurate result for a given simulation.

Mathematically, the error is computed along the following lines.

E.:l,pp;'&x
Let be the solution to step 2 above. This value is inserted in the following equation
! A 2 ®)
Vx| —VxE|-ky g,E = 0
Uy
yielding
"1 ) 2 ©)
T-"xfx "TT-"XE&FWEJJ; —ky E?Eapprm = residue
s

For each tetrahedron in the mesh, the residue function is evaluated. A percentage of the
tetrahedra with high residue values are selected and refined.

The following figures illustrate the automated adaptive mesh refinement solution process that is
used by HFSS for the simulation of a patch antenna.

Fundamentals of HFSS 1-10
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| refine
_|mesh

Geometry " Initial mesh
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Figure 1-6 Adaptive mesh refinement example

Computational Volume and its Parts

A computational volume or solution space is the volume within which HFSS explicitly calculates
the electromagnetic fields.

Fundamentals of HFSS 1-11
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Figure 1-7 Computational volume containing a connector

A computational volume essentially consists of all the regions and objects inside which you want
to determine the electromagnetic fields. The outermost surfaces of the computational volume
are generally referred to as outer faces or outside boundaries. These faces are the outermost
boundaries of the model, and HFSS explicitly calculates all fields within the solution space that
these boundaries define. All field quantities that are calculated by HFSS outside the
computational volume are derived from the fields within the solution space.

Solution Types

Before creating the design, you must specify the type of solution that you want HFSS to
calculate. The following solution types are available:

HFSS: The default solution type for HFSS designs.

HFSS with Hybrid and Arrays: Adds the ability to define hybrid regions and arrays in the
HFSS design.

Transient: Used for calculating problems in the time domain. Transient solutions are
applicable for simulations involving pulsed excitations (for example, lightning strikes).

SBR+: Simplifies design creation for SBR+ users. HFSS can use Shooting and Bouncing
Ray (SBR) technology to calculate the far field from current sources and defined geometry
via one-way coupling. With this solution type, you do not need to specify explicit SBR+
Hybrid Regions.

Eigenmode: This solution type provides results in terms of eigenmodes (or resonant
frequencies) of a given structure. The solver provides the resonant frequencies as well as
the fields at a particular resonant frequency.

Characteristic Mode: This solution type is used for calculating the characteristic modes
of a structure. The structure can be metal (conductor) or dielectric. The solution reports

Fundamentals of HFSS 1-12
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the number of modes, the characteristic angle and current (amp/meter), the modal
significance and quality factor, and the voltage per port based on edit source weightings.

Solution Type: Projectl - HFS5Design >

Salution Types
f* HFSS

" HFS5 with Hybrid and Arays
" Transient

" SBR+

" Eigenmode

" Characteristic Mode

Ophions

& Metwork Analysizs © Composite Excitation
" Modal {* Terminal

| Auto-Open Region

[ Save az default

k. | Caricel

Figure 1-8 Solution Type Dialog Box for HFSS Designs

Solution Type Options

Three additional options are available for the HFSS, HFSS with Hybrid and Array, and
Transient solution types only.

« Choose one of the following two options:
° Network Analysis: The default solution option for applicable solution types.

° Composite Excitation: This option provides a method for solving fields in a large
frequency domain problem.
« Auto-Open Region: This option is typically used for antenna simulations. It automatically

creates an open region and a predefined analysis setup for the project. You can select
whether the region is Radiation, FE-BI, or PML. This option simplifies the design process.

Fundamentals of HFSS 1-13
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If you do not choose Auto-Open Region, you must create an air box and then assign a
radiation boundary, either manually, or using the Create Open Region command.

Two additional options are available for HFSS and HFSS with Hybrid and Array solution types
only.

e Choose one of the following two options:

o Modal: This option yields S-matrix solutions that are expressed in terms of the
incident and reflected powers of transmission line modes.

o Terminal: The default option for applicable solution types. This option yields S-
matrix solutions that are expressed in terms of terminal voltages and currents. For
simulations that deal with signal integrity, the Terminal solution option is preferred.
Such problems generally include transmission lines with single wave or multiple
conductors.

Modal Option versus Terminal Option:

If HFSS is used to model a pair of coplanar, parallel microstrip transmission lines, a driven modal
solution yields results in terms of the even and odd modes that propagate on the structure,
whereas a driven terminal mode solution generates the common and differential mode results.

HFSS Simulation Examples

The design below represents a terminal solution of a differential pair of vias. A pair of lines
transition through circuit board vias to a pair of striplines on a lower layer. The two microstrip
lines and the striplines are each assigned a terminal in the coupled microstrip port. The
conductors are copper, and a radiation boundary is applied to the air box. The design was
solved at 4.38 GHz, and the electric field plots on the surfaces of the wave ports with terminals
are shown in the following figure:

Fundamentals of HFSS 1-14
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Figure 1-9 Terminal Solution of a Differential Pair of Vias

The following figure represents a modal solution of a connector between a coaxial and microstrip
line:

Fundamentals of HFSS 1-15
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Figure 1-10 Connector between Coaxial and Microstrip Line

The following figure demonstrates a 3D finite element transient simulation of a lightning strike on
a helicopter. Large currents flow through the aircraft skin generating electromagnetic field with
the potential to damage sensitive equipment within. By using a transient simulation such
challenges can be predicted early in the design phase saving costly empirical testing.

Figure 1-11 Lightning Strike Simulation of a Helicopter

Network Analysis and Composite Excitations

Network Analysis and Composite Excitations are used with driven modal, terminal, and transient
problems. These options determine how HFSS applies excitations on a design during the
adaptive refinement solution process.

When the Network Analysis option is selected, HFSS solves the design by exciting the ports
individually and loading the remaining ports by matched characteristic impedances. Therefore,
the number of solutions that HFSS calculates is equal to the number of ports on a design.

When the Composite Excitations option is selected, all the existing ports in a design are
excited at the same time so HFSS needs to solve the design just once. The solution generated
by Composite Excitations is much faster than Network Analysis.
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2 - HFSS Boundaries

* "The Purpose of Boundaries in HFSS" below

« "The Different Boundary Conditions in HFSS" on page 2-4
* "Anisotropic Impedance" on page 2-6

¢ "Finite Conductivity" on page 2-9

¢ "Impedance" on page 2-10

» "Layered Impedance" on page 2-10

e "Lumped RLC" on page 2-11

» "Primary/Secondary (Lattice Pair)" on page 2-13

» "Perfect Electric Conductor" on page 2-14

» "Perfect H" on page 2-15

« "Radiation Boundary" on page 2-16

¢ "Symmetry" on page 2-17

» "Perfectly Matched Layer (PML)" on page 2-19

* "How to Apply Boundary Conditions" on page 2-20
» "Auto-Open Region" on page 2-22

» "Create Open Region" on page 2-23

The Purpose of Boundaries in HFSS

The purpose of using boundary conditions in HFSS is to define the behavior of the
electromagnetic field on the object interfaces and at the edges of a problem region. Defining
boundary conditions reduces the electromagnetic or geometric complexity of the model.

A closed model represents a structure or a solution volume where no energy escapes except
through an applied port. For an Eigenmode simulation, this closed model represents a cavity
resonator and for a driven modal or terminal solution, the model can be a waveguide or some
other fully enclosed structure.

An electromagnetically open model allows energy to emanate or radiate away. Common
examples include an antenna, a printed circuit board, or any structure that is not enclosed within
a closed cavity.

By default HFSS treats any given model as closed since all outer surfaces of the solution space
are covered with a perfect electric conducting boundary. In order to create an open model, you
must specify a boundary on the outer surfaces that overwrites the default perfect electric
conducting boundary.

Boundary conditions are assigned on 2D sheet objects and surfaces of 3D objects.

HFSS Boundaries 2-1
Ansys Electromagnetics Suite 2025 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



An Introduction to HFSS™

Every HFSS model that you create uses boundaries on the outer surfaces of the solution space.
Depending upon the type of boundary specified any given HFSS model has a conducting,
radiation, or a perfectly matched layer (PML) boundary condition on all outer surfaces.
Conducting boundaries are the perfect electric conductor (PEC), finite conductivity, or
impedance boundary.

Note: For more information about a complete list of boundary conditions see the section The
Available Boundaries in HFSS.
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Electromagnetically open models Electromagnetically clozed models

Tee Wavezuide

Cavity Resonator

Printed Circuit Board

Aperture Coupled
Alicroztrip Filter:

Coax Bend

Figure 2-1 Sample HFSS electromagnetic structures
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The Different Boundary Conditions in HFSS

Boundaries specify the behavior of magnetic and electric fields at various surfaces in the model.

Aszign Boundary H Anisotropic Impedance...
Assign Excitation b Aperture...
Assign Hybrid » Coupled... b Lattice Pair...
Assign Mesh Operation b Finite Conductivity... Primary...
Plot Fields g Half Space... Secondary....
Plot Mesh... L a Aute ldentify lattice pair...
Layered Impedance... r
Plot VRT } Linked Impedance...
Copy Image Lurnped RLC...
Perfect E...
Perfect H...
Radiation...

Multipaction SEE...
Symmetry...
Fresnel (SBR+)

PML Setup Wizard...

Figure 2-2 Available boundaries in HFSS
The following types of boundary conditions are available in HFSS:
Anisotropic Impedance

Anisotropic impedance boundary condition represents a sheet with different impedance
values from different tangential directions taking the polarization of the incident field into
account.

Aperture
Represents a hole in a metallic sheet assigned as an |IE Region.
Finite Conductivity

Finite Conductivity boundary condition allows creation of single layer conductors. Finite
conductivity boundaries represent imperfect conductors and is valid only if the conductor being
modeled is a good conductor.

Fresnel (SBR+)

HFSS Boundaries 2-4
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Represents either a perfect absorbing boundary or a user-defined Fresnel table file that
describes a good approximation of the reflection of an arbitrary wavefront off a surface.
Supported for driven modal/terminal and SBR+ solution types.

Half Space

Represents a background comprising a dielectric half space. For antenna and scattering
problems in HFSS in which all objects are assigned as Hybrid IE Region.

Impedance

An impedance boundary condition represents a resistive surface; it allows creation of ohm
per square material layers.

Lattice Pair

A Coupled pair, the same as one Primary Boundary and one Secondary Boundary together, but
with an auto-set coordinate system. A red arrow points from the primary to the secondary face of
the Lattice Pair.

Layered Impedance
Layered impedance boundary is used to model multi-layered conductors and thin dielectrics.
Linked Impedance

Represents a data link to an isotropic or anisotropic impedance boundary in another design.
These can include infinite ground planes and shell elements.

Lumped RLC

Lumped RLC allows creation of ideal circuit components. It represents any combination of
lumped resistor, inductor, and/or capacitor in parallel on a surface.

Multipaction SEE

For Multipaction Analysis, this represents multipaction Secondary Electron Emission (SEE). The
Multipaction SEE boundaries should be added to vacuum-material interfaces where secondary
electrons will be generated.

Perfect E
Represents a perfectly conducting surface.
Primary

Primary represents a surface on which the E-field at each point is matched to another surface
(the Secondary boundary) within a phase difference. It's used with secondary boundary to
model infinitely large repeating array structures.

Perfect H
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Perfect H represents a surface where the tangential component of H is zero.
PML

Represents an open boundary condition using several layers of specialized materials that
absorb outgoing waves. A PML is used to create an open boundary condition using several
layers of specialized materials for absorbing outgoing waves. PML boundary conditions are
preferred for antenna simulations.

Radiation

A radiation boundary is used to create an open model. It represents an open boundary by
way of an absorbing boundary condition ABC that absorbs outgoing waves.

Secondary

Secondary represents a surface on which the E-field at each point has been forced to match
the E-field of another surface (the primary boundary) within a phase difference. It's used with
primary boundary to model large infinitely repeating array structures.

Symmetry
Symmetry boundary represents a perfect E or perfect H plane of symmetry.

A PML is used to create an open boundary condition using several layers of specialized
materials for absorbing outgoing waves. PML boundary conditions are preferred for antenna
simulations.

All these different types of boundary conditions are discussed in detail in the following sections.
Anisotropic Impedance

Anisotropic impedance boundary is a special impedance boundary which can be applied when
the relationship between the electric field and magnetic field depends upon the direction. The
relationship has to be defined in two orthogonal directions which form the main axes x and y.

E =Z (nxH),+Z (nxH) E,=Z, (nxH) +Z (nxH),

This boundary condition is described by a 2 by 2 matrix as shown below:

The example shown below demonstrates the anisotropic impedance boundary condition. The
following Z matrix was applied for a parallel plate waveguide with different E field polarizations.
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z =901 0 lohms
0 1000

In effect this Z matrix represents a short circuit for E field polarization along the x direction and
open circuit for E field polarization along the y direction. This is illustrated in the following figures.

Z matrix can be expressed in analytical form or can be imported from another external design.
This is called the screening impedance boundary condition. The external design is usually a unit
cell model of a periodic structure, which shows different electromagnetic behavior in different
directions.
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Figure 2-3 Parallel plate waveguide showing the effects of assigning anisotropic
impedance

Finite Conductivity

The Finite Conductivity boundary is used to model conductors as 2D sheet objects. This
boundary condition is used when modeling planar antennas or traces on a PCB where the
thicknesses are very small but larger than the skin depth. Finite conductivity boundary condition
efficiently models signal traces, ground planes, or a radiating element. The following figure
illustrates a microstrip filter with apertures. Since the thickness of the trace and the ground plane
is small but larger than the skin depth they can be replaced by sheet objects with finite
conductivity boundary conditions assigned to them.

Figure 2-4 Filter model showing Finite Conductivity boundary applied to the trace and
the ground plane

This boundary is also known as finite conductivity boundary condition of finite thickness. When
an object cannot be replaced by a sheet, HFSS automatically takes the effective thickness into
account known as DC thickness boundary condition. Finite conductivity is also applied to
replace large conducting objects by assigning a sheet boundary condition on the surface. This
boundary condition is called Finite Conductivity Boundary of infinite thickness or classical skin
impedance and is applicable only when the skin depth is much smaller than the size of the
object. Finite conductivity boundary condition also allows you to specify the surface roughness
of the conducting object on which it is assigned.
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Impedance

The Impedance boundary condition represents a resistive or reactive surface or both. It's
commonly used to simulate thin materials that have an ohms per square characterization or thin
film resistors. Impedance boundary condition is complex and in some cases it’s frequency
dependent.

Figure 2-5 Smartphone showing the Impedance Boundary applied to a specific inner
surface in order to model conductive paint

Layered Impedance

The Layered Impedance boundary condition is used to model structures that are composed of
layers of conducting and/or dielectric materials. This boundary condition is commonly used to
model thin multiple plating layers of metallic objects with thin dielectric coatings. Layered
impedance boundary condition models multiple layers in a structure as a single equivalent
impedance surface. If desired, this boundary can also take into account the conductor surface
roughness. Layered impedance is extremely useful since it eliminates the need to mesh thin
layers, which in turn, reduces the complexity of the problem and simulates a structure quickly
and efficiently. This boundary condition can be specified either on internal or outer surfaces. If
it's defined on internal sheet objects (that are two sided) there is an option to use shell elements.
Shell elements are advanced layered impedance boundary conditions duplicating the electric
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field on the sheet objects. By way of this the tangential electric field can be discontinuous. Shell
elements model shielding effects of conducting layers accurately and efficiently.

I
[
|

==

Figure 2-6 Connector model (some parts hidden for clarity) showing the Layered
Impedance Boundary applied to surfaces of the connector female center pin

Lumped RLC

The Lumped RLC Boundary is used to model ideal lumped elements like resistors, inductors or
capacitors. This boundary can be used to model single elements or multiple R, L, orCina
parallel combination. The following figure shows a capacitor microstrip model showing the RLC
boundary applied to a plane internal to the capacitor body.
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Figure 2-7 Lumped RLC boundary example

Lumped RLC boundary is a modified impedance boundary. Unlike the Impedance boundary
Lumped RLC can be used to directly specify a resistor, inductor, or capacitor value in an HFSS
simulation. Once the values of R, and/or L, and/or C are specified, HFSS determines the
impedance per square of the lumped RLC boundary at each frequency, effectively converting
the RLC boundary to an impedance boundary.

A parallel combination of RLC components is obtained by simply specifying values for either two
or all three lumped components within the same boundary dialog box. To create series circuits,
the RLC boundaries must be applied to two adjoint 2D objects arranged end—to-end. This is
shown in the graphic below.

Figure: Microstrip model showing the RLC Figure: Microstrip model showing the RLC
Boundary applied to a 2D sheet object in order to [|[Boundary applied to two end-to-end 2D
model a single inline resistor, or inline parallel sheet objects to model a series combination
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combination of lumped components. of inline resistor and capacitor.

Primary/Secondary (Lattice Pair)

The combination of Primary and Secondary boundaries is useful when modeling large repeating
or periodic structures. Commonly these boundaries are used to model infinite antenna arrays or
frequency selective surfaces.

Figure 2-8 Primary/Secondary Boundary pair on opposite faces of a unit cell of an
infinite array of Vivaldi antennas

Unit cell of an infinite array of Vivaldi antennas showing a Primary/Secondary Boundary pair
applied to opposite faces of the unit cell.

In Detail

When using a Primary and Secondary pair, the E-field on the Secondary surface matches the E-
field on the Primary surface within a phase difference.

Primary/secondary boundary pairs can only be assigned to outer faces of the solution space.
These faces should be planar. Additionally, the geometry in contact with the Primary boundary
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must be identical to the geometry in contact with the secondary boundary. If the geometries on
the primary/secondary pair are not identical, the design cannot be solved.

Each primary and secondary boundary needs a coordinate system that you specify to define the
plane on which the boundary exists. These coordinate systems must match each other. If they
do not match each other, HFSS automatically transposes the secondary boundary to match the
primary boundary. If the resulting primary/secondary surfaces do not have the same relative
position, an error occurs.

Perfect Electric Conductor

Assigning a perfect electric boundary condition on a surface of an object causes the tangential
component of the electric field to be zero. This type of boundary models a perfectly conducting
surface in a structure that forces the electric field to be normal to the surface.

Since no electromagnetic field exists inside 3D objects with pec material, HFSS treats the
surfaces of these objects as PEC boundaries. You can define PEC boundary on 2D sheet
objects to represent lossless conductors such as transmission line traces or patch antenna
elements. When assigning a PEC boundary on a surface that represents the “ground” plane of a
radiating structure, select the Infinite Ground Plane option if you want to model an infinite ground
plane.

In HFSS, PEC is a default boundary condition on all outer surfaces of the computational domain.

The PEC boundary can also be used to create a symmetry plane in a model. In this type of
symmetry the E field components are normal to the plane. In the dielectric resonator antenna
model shown below, the bottom face of the air volume object is defined as a perfect E boundary.
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Figure 2-9 Perfect E boundary assigned on the bottom surface of the air volume object

Perfect H

The Perfect H Boundary can be used to create a natural boundary through which fields
propagate, or it can be used to model a perfect magnetic conductor.
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Figure 2-10 Slotted waveguide antenna array with slots assigned perfect H boundary

The Perfect H boundary can be applied either internally to a model or at an outer face of the
solution space. Ifis it applied internally, this boundary forces the tangential components of the H
field to be identical on both sides of the surface to which it was applied. If this surface is a
conducting body, then the perfect H boundary creates an aperture through which energy can
propagate.

If this boundary is applied to an outer face of the solution space, it is equivalent to a perfect
magnetic conductor, where the tangential H field is zero.

Radiation Boundary

The Radiation Boundary is used to create an open problem in HFSS that allows electromagnetic
waves to radiate infinitely far into space as in the case of antenna designs. HFSS absorbs the
wave at the radiation boundary, essentially ballooning the boundary infinitely far away from the
structure. Radiation boundary is applied only on outer faces of the solution space. When
simulating an antenna place the radiation boundary approximately at a quarter wavelength away
from any radiating surface.

The following example shows a probe feed patch antenna design. Radiation boundary is
assigned on all outer surfaces of the air box enclosing the antenna except the bottom face,
which is a conductor in the real model.
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Figure 2-11 Sample HFSS model of a probe feed patch antenna showing radiation
boundary

The radiation boundary condition is an approximation of free space. The accuracy of the free-
space approximation depends on the distance between the boundary and the closest
radiation/scattering object.

Symmetry

The Symmetry Boundary can be used to reduce the overall size of a model by applying it along a
plane of geometric and/or electrical symmetry. The symmetry boundary are of two types: the E
symmetry and H symmetry.
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Figure 2-12 Pyramidal horn antenna model showing the perfect H Symmetry Boundary
applied to symmetry plane

Symmetry boundaries represent perfect E or perfect H planes and enable you to model only part
of a structure, which reduces the size or complexity of the design and shortens the solution time.
When a symmetry boundary is applied, the electromagnetic field is forced to be either tangential
or normal to the symmetry plane. If an E-symmetry plane is used, the electric field is forced to be
normal to the symmetry plane; in other words the tangential component of the electric field is
zero.

An H-symmetry plane forces the magnetic field to be normal to the plane of symmetry; in other
words the tangential component of the magnetic field is zero.

Symmetry planes can be applied only to outer faces of the solution space. The symmetry plane
must be planar. For an HFSS simulation, a maximum of three orthogonal symmetry planes can
be used.
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Note: Symmetry boundary conditions are nothing other than perfect E and perfect H boundary
condition.

When calculating far field the post processor mirrors the solution according to the symmetry
conditions.

Two common examples of a symmetry boundary are shown below. (Only the modeled halves

are shown.)

Coaxial Cable Model Coplanar Microstrip Pair

/H Plane symmetry

E lectric field vectors
shown in red ink

E plane symm etry /

|
|
|
|
f: »
|
|
|
|
|

: I . .
The H symmetry isused since that boundary enforces TheE symm etry isused since T:h‘“
the tangential component of the magnetic field to be boundary enforces the tangential
zero on the surface marked by the dashed line. component of the electric field to be zero

on the surface marked by the dashed line.

This boundary is not available for models using the Driven Terminal Solution type.

Perfectly Matched Layer (PML)

The Perfectly Matched Layer or PML Boundary is also used to create an open model. Like the

Radiation Boundary, it should be applied only on the outer faces of the solution space. Itis also
the preferred boundary condition when simulating antennas.
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Figure 2-13 Radar cross-section with Perfectly Matched Layer Boundary

Perfectly matched layers, though not boundaries in a strict sense, are fictitious materials that
absorb the electromagnetic fields impinging upon them. These materials have complex and
anisotropic material properties.

Perfectly Matched Layers (PMLs) are the preferred boundary when simulating antenna models
and they are more appropriate than radiation boundaries for antenna simulations. PMLs can
reduce the solution volume since they can be positioned at a distance 1/10 times the wavelength
close to any radiating structure. For modeling antennas, it is recommend to keep the PML a
quarter of a wavelength away from any radiating structure.

Perfectly matched boundaries are automatically generated with the aid of the PML Wizard. This
wizard guides you through the creation of the PML objects/materials.

How to Apply Boundary Conditions

Boundary conditions are applied either on 2D sheet objects or one or more faces of 3D objects
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Assign Boundary L] Anisotropic Impedance...
Assign Excitation ¥ Aperture...
Assign Hybrid g Finite Conductivity...
Assign Mesh Operation ¥ Half Space...
Plot Fields b Impedance...
Layered Impedance...
Plot Mesh Lumped RLC...
Copy Image Master...
Perfect E...
Perfect H...
Radiation...
Slave...
Symmetry...

PML Setup Wizard...

Figure 2-14 Applying boundaries
To apply a boundary condition on a model, perform the following steps.

1. Press the F key to enter the face selection mode.
2. Select a single surface of the model or select multiple surfaces of the model to apply a
boundary.

Note: If you want to assign a boundary condition on all surfaces of the model, select a face on
the model and right-click to select All Object Faces.

3. Right-click and select Assign Boundaries and click the appropriate boundary condition
from the short-cut menu.
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This command brings up the dialog box of the selected boundary type. After you define the
appropriate boundary condition settings in the dialog box that appears, the boundary condition
gets assigned on a single face, multiple faces or on all object faces depending upon your
selection.

Alternatively click the surface or multiple surfaces to apply boundary, select the menu item
HFSS and go to Boundaries > Assign > and select the appropriate boundary.

Auto-Open Region

The Auto-Open Region option appears on the Solution Type dialog box as an HFSS Driven
soltution, and it is used with a driven modal, terminal or a transient options for a design.

For an open problem such as an antenna array design, the air volume enclosing the outer
radiating surfaces is modeled by a surrounding object. On the outer surfaces of this object,
boundary conditions such as radiation boundary, PML, or FEBI are assigned to absorb all
outgoing waves.

If you select the Auto-Open Region option, HFSS automatically creates an invisible bounding
region with the default absorbing boundary conditions (ABC) on the outer surfaces of this region.
This command eliminates the need to manually create an air box or define a region and assign
radiation boundary conditions on the outer surfaces of the air box or the region.

If you want to override the default radiation boundary with a FEBI boundary for a driven modal or
terminal problem, select the FEBI option under the Auto-Open Region check box.

In addition to creating the region object, the Auto-Open Region command also automatically
adds a solution setup with a default frequency of 1 GHz. Depending upon your requirements you
can adjust the solution frequency; as a result the invisible region object is automatically resized.

Generally the Auto-open Region command is used when you are interested in viewing the
radiation pattern of a device such as an antenna. S-parameters are also obtained. The figure
below shows the radiation pattern for a five element array of flared dipole antennas with a trough
reflector solved using the default settings of the Auto-Open Region mode.
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Figure 2-15 Planar dipole antenna array solved using auto-open region

Note: See Create Open Region for an alternative method for treating open problems in HFSS.

Create Open Region

The Create Open Region command automatically creates an open region to model the air
volume enclosing the design and assigns boundary conditions on the surface of the region
depending upon your selections. You can select a radiation boundary (ABC), FEBI or PML
boundary condition on the Create Open Region dialog box. You can also choose an infinite
ground plane.

The padding for the region is determined by the operating frequency. This operating frequency is
the same as the frequency defined in the solve-setup. If there is no solve-setup defined, the
operating frequency defaults to 1 GHz.

If you adjust the adaptive frequency on the solve setup, you can update the operating frequency
on the Update Open Region dialog box. The padding (PD) for the region is determined by the
following rules:
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« PD = A/ 3, for radiation boundaries (or ABC)
« PD=A/8, for FEBI boundaries
e PD=A/4,for PML boundaries

Note: A (Lamda) is the wavelength at the specified solution frequency. A = ¢ / f, where fis the
operating frequency in Hertz, and c is the speed of light in a vacuum.

For a design with multiple solution setups, you only need to create the region once and update
the operating frequencies accordingly to ensure the appropriate region padding.

The figures below show the model of a planar flared dipole array antenna and the total gain of
the antenna array using the Create Open Region command with PML boundary. The same
model was also solved in the Auto-Open Region mode with ABC and from the plots it is clear
that results agree.

= dB{GainTotal)
Setup1 : LastAdaptive
Freq="1.8GHz Phi="%0deq’

— dB(GainTotal)_1
Imported
Freg="1.8GHz' Phi="80deqg’

-180

Figure 2-16 Planar Flared Dipole Antenna Array

Note: You cannot create an open region if the Auto-Open Region option is checked. If the
Auto-Open Region mode is active and you clear the Auto-Open Region check box, then the
bounding box along with the ABC or FEBI boundary becomes visible.
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3 - HFSS Excitations

» "Excitations in HFSS" below
* "Wave Ports" on the next page

« "Terminal Wave Ports" on page 3-5

¢ "Lumped Ports" on page 3-5

» "Difference between Lumped Ports and Wave Ports" on page 3-8

* "Floquet Ports" on page 3-9

* "Incident Waves" on page 3-10

¢ "Linked Fields" on page 3-10

Excitations in HFSS

In HFSS, excitations are sources of electromagnetic fields in a design. There are many types of
excitations in HFSS. They are listed below:

Wave Ports

Lumped Ports

Floquet Ports

Terminal

Incident Wave

Linked Fields

Current Sources
Voltage Sources
Magnetic Bias Sources

All excitation types provide field information, but only the wave port, lumped Port, and Floquet
port provide S- parameters. The use of the magnetic bias source allows you to model a magnetic
bias acting on a ferrite material.
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Figure 3-1 Bandpass filter with ports

By assigning excitations you define sources of electromagnetic fields. The most commonly used
types of excitations are ports. They are of two types: wave ports and lumped ports. They provide
S, Y, Z parameters and field information. Additionally, wave impedance and propagation
constant that is gamma are obtained if you assign a wave port. Gamma and wave impedance
are related to the transmission line structure represented by the wave port. Depending upon the
solution type, wave ports and lumped ports can be either modal or terminal. Terminal wave ports
or terminal lumped ports are used for signal integrity problems.

For periodic structures defined by primary/secondary (Lattice pair) boundaries Floquet ports are
used.

There are several types of analytically defined incident field excitations of which plane wave is
the most common. Linked field come from other designs by using data link and/or
measurements.

Wave Ports

Wave ports are used to excite transmission lines like microstrip, stripline, coplanar waveguides,
and hollow waveguides. A wave port represents the region through which electromagnetic
energy enters or exits the solution space. In HFSS a wave port is treated as if it were a semi
infinitely long waveguide or transmission line of the exact same cross-section attached to the
model where it's excited.

Wave ports yield S,Y,Z parameters, characteristic wave impedance, and the propagation
constant gamma. The S-parameters generated by a wave port are normalized to the matched
loads and can also be normalized to any constant complex impedance.

S-parameters can be de-embedded into or out of a port. This operation subtracts or adds
transmission line length to the model changing the S-matrix accordingly.
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A wave port excitation should be applied only to an outer face of the solution space. HFSS first
calculates a 2D solution for the wave port and subsequently uses that solution as the source for
the 3D model. HFSS treats each wave port as if it were connected to a semi-infinite waveguide
or transmission line that has the exact same cross-section and material properties as the port.
Initially, 2D fields in this semi-infinite waveguide that are solved. Those same fields are
impressed onto the port region of the 3D model to obtain a solution to the 3D model.

HFSS generates a solution by exciting each wave port individually, wherein each desired
incident mode contains 1 Watt time-averaged power. To find a solution to a given port, the
desired port is energized with 1 watt of power while all other ports have matched loads.

When creating a wave port in the driven modal solution type, you must specify the number of
modes desired. For signal integrity problems, the number of modes should be set equal to the
number of signal traces that are enclosed within the given wave port. For example, in the case of
a co-planar pair of microstriplines enclosed within a single wave port, two modes should be
specified. In the final solution, these two modes represent the even and odd modes of
propagation.

Some examples of commonly used wave ports are shown below.

The following figure represents differential pair via model with a pair of lines transitioning through
the vias to a pair of striplines on a lower layer. Wave ports have been defined as shown below on
the differential pair via model. There are four terminals at the intersections of the conducting
objects with the port face.

Figure 3-2 Differential via pair model showing wave ports and terminals
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Wave ports assigned on waveguide structures are naturally defined by the cross-section of the
waveguides. For transmission lines (i.e. microstrip, coplanar waveguides, slotline etc.) ports

should be defined carefully. Also, placement of a wave port is critical since it can affect the
accuracy of the solutions.

Note: For more information see the topics Wave Port Size and Wave Port Placement in the help.

Additional examples of models with appropriate wave port dimensions are shown below.

Waveguide Coaxial Cable Microstrip

Figure: Port size 1s determined
by mnner dimensions of
waveguide.

Figure: Bottom of port touches
ground plane of microstrip.

Figure: Port size 15 determined

by mner radius of shield.

Stripline Co-planar Waveguide

Figure: Port height 15 determined by ground ] _
plane spacing. and port touches both upper and Figure: Left and right edges of port should
lower ground planes. touch left and nght ground planes of CPFW.

For Modal Wave Ports, the user must set all propagating modes. For Terminal Wave Ports,

HFSS automatically determines the location and number of all quasi TEM modes that are
needed.
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Terminal Wave Ports

Terminals are the ends of signal traces that intersect the plane of a port. To fit circuit theory
HFSS has options for assigning terminals and expressing the relationship between currents and
voltages.

Terminals are especially useful when you are dealing with circuit simulators since the S-
parameters obtained in terms of currents and voltages are in a format that is compatible with
most circuit simulators. The terminals for the transmission line below are T1, T2, T3, T4.

Figure 3-3 Transmission line examples

Lumped Ports

Lumped Ports are commonly used excitation types in HFSS. A lumped port is analogous to a
current sheet source and can also be used to excite commonly used transmission lines. Lumped
ports are also useful to excite voltage gaps or other instances where wave ports are not
applicable. Generally they are applied internally to the solution space.

Shown below are examples of commonly used lumped ports on a microstrip model applied
between the signal traces and the ground plane.
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Figure 3-4 Lumped ports excitations
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g
g

( region represents the lumped port.)

Port is internal to the solution Port is internal to Solution Space. The |Portis internal to
Space. The 2D port rectangle 2D port rectangle touches the signal  |[Solution Space.
touches the signal trace with one trace with one edge, and the opposite |[Portis an annular
edge and the opposite edge edge touches user-drawn PEC objects |[ring around BGA
touches the ground plane. (gray.) Ball.

Lumped ports yield S,Y,Z parameters and fields, but they do not yield any gamma or wave
impedance information. The results of a lumped port cannot be de-embedded but can be
renormalized. Unlike wave ports, lumped ports can support only a single mode. A lumped port
can be defined on any 2D object that has edges in contact with two conducting objects. The
boundary that is applied to all edges that do not touch a conductor is a perfect H, which ensures
that the normal electric field is equal to zero on those edges.

The complex impedance Zs defined when the port was created, serves as the reference
impedance of the S-matrix of the lumped port. The impedance Zs has the characteristics of a
wave impedance; it is used to determine the strength of a source, such as the modal voltage V
and modal current I, through complex power normalization.

It should also be noted that when the reference impedance is a complex value, the magnitude of
the S-matrix is not always less than or equal to 1, even for a passive device.
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Difference between Lumped Ports and Wave Ports

Wave ports are applied at outer faces, yield S, Y, Z parameters, fields, wave impedance,
gamma, and can be deembedded.

Generally lumped ports are applied internally, yield S,Y, Z parameters and fields. Both can be
renormalized to a specific real impedance.

Port applied Gamma | Yields 5,Y,Z | Renormalize De-embed
Wave externally yes yes possible possible
Lumped | internally no yes possible not possible

The main differentiator between lumped ports and wave ports is the location of where they are
applied to the model. Wave ports should only be applied at outer faces of the solution volume,
whereas the lumped port should only be used internally to the solution volume.

Another key difference is that wave ports are specifically suited to sourcing ideal transmission
lines, while lumped ports are well suited to sourcing structures that are not ideal transmission
lines such as BGA balls, bondwires, etc.
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Lumped ports are also called gap ports. This is because the height of the lumped port is small
when terminating feeding non-ideal transmission lines.

Floquet Ports

A Floquet port in HFSS is exclusively used for planar-periodic structures. Typical examples are
planar phased arrays and frequency selective surfaces when these may be idealized as infinitely
large. The analysis of the infinite structure is accomplished by analyzing a unit cell. When you
define a Floquet port, a set of modes known as Floquet modes represent the fields on the port
boundary. The Floquet modes are plane waves with propagation direction set by the frequency,
phasing, and geometry of the periodic structure.

To illustrate a unit cell of an infinite phased array of vivaldi antennas can be simulated using
linked boundaries and a Floquet port. The upper face of the unit cell is terminated in a Floquet
port as shown in the following figure.
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Figure 3-5 Floquet Ports example on a unit cell

Incident Waves

An incident field is the electromagnetic field in the absence of any scatterers. Incident fields are
of the following types:

* Plane Wave

Hertzian-Dipole Waves
Gaussian Beam

Linear Antenna Wave

Cylindrical Wave

The most commonly used incident wave is the plane wave. For example, incident plane wave
source excitations can be used to see the scattering from a standard radar cross-section model
of a conducting ogive.

Figure 3-6 Incident plane wave on an aluminum ogive

Linked Fields

Linked fields are of two types:

e FarField Wave
* Near Field Wave
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A far field wave originates at a distance several wavelengths from the computational domain.
Far field values are defined on the surface of a unit sphere. When you use a Far Field link, the
origin of the global coordinate system of the source project should be in the phase center of the
antenna.

A near field wave source is close enough to the design, typically within one wave length. The
radiation surface of the near field source project cannot coincide with the surface of the target
project where the incident field pings in.

The following design of a dish antenna fed by a circular horn antenna can be used with near field
sourcing to run a range of analyses.

Figure 3-7 Near Field example of a dish antenna

Both the near and far field link establishes a one-way link. The feedback from the target to the
source is neglected.

HFSS Excitations 3-11
Ansys Electromagnetics Suite 2025 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



An Introduction to HFSS™

PDF layout 3-12
Ansys Electromagnetics Suite 2025 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



An Introduction to HFSS™

4 - HFSS Solution Setup

¢ "Driven Solution Setup" below

» "General Tab" on page 4-5

» "Solution Frequency Setting for Advanced Setups" on page 4-5
« "Adaptive Solutions" on page 4-6

» "Options Tab" on page 4-7

 "Initial Mesh Options" on page 4-8

» "Adaptive Options" on page 4-8

» "Advanced Solution Setup Options" on page 4-8

» "Adaptive Options" on page 4-8

 "Initial Mesh Options (Advanced)" on page 4-9

« "Port Options" on page 4-9

« "|IE Solver Options" on page 4-9

* "Fields" on page 4-10

» "Expression Cache Tab" on page 4-10

» "Defaults Tab" on page 4-10

» "Transient Solution Setup" on page 4-10

* "Transient Solver" on page 4-11

¢ "Input Signal" on page 4-12

« "Duration" on page 4-13

« "Save Fields" on page 4-13

+ "Radiated Fields" on page 4-13

« "HPC and Analysis Options" on page 4-13

* "Domain Decomposition" on page 4-14

e "The Maximum Number of Passes and Maximum Refinement Per Pass" on page 4-15
* "Frequency Sweeps" on page 4-16

» "Differences between Local, Remote and DSO solutions" on page 4-19

Driven Solution Setup

A driven solution setup is defined for an HFSS Driven modal or a terminal project. Defining a
solution setup enables HFSS to compute a solution for a design. You can define multiple solution
setups for the same design. As illustrated in the following figure if you right-click Analysis on the
Project Manager window and select the Add Solution Setup option from the short cut menu,
you can select, Auto or Advanced.
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If you select Auto..., the following Solution Setup window appears.
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Driven Solution Setup >

General | Derivatives ] Defaults ]

Setup Mame: Setup 2 ¥ Enabled
Auto Solver Setting
Fast Balanced Accurate
1 1 1
Y
5]
Sweep Type: |Ir|ter|:u:|lating j

Frequency Sweeps [451 points defined]

Distribution Start End

I Linear Count

Add Above Add Below Preview ...

Fields
[ Sawe Fields

r

lse Defaults

HPC and Analysis Options... ‘

QK | Cancel |

This offers a slider bar with choices for Fast, Balanced or Accurate settings, choices for Sweep
Type, and one predefined Frequency Sweep.

If you select Advanced..., the following Solution Setup window appears. You can specify the
settings on the Solution Setup window for computing a solution for a design. If you want a
Frequency Sweep, you add that separately.
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Driven Solution Setup

General letin:nns ] Advanced ] Hybrid ] Expression Cache | Dervatives ] Defaults ]

Setup Name |Setup |

[v Enabled [ Solve Poris Only

Adaptive Solutions

Solution Frequency: * Single " Multi-Frequencies (" Broadband
Freguency | 5 GHz j
Maximum Mumber of Passes | 6

(¥ Maximum Delta 5 | 0.02

(" Use Matrix Convergence

Use Defaults

HPC and Analysis Options...

o |

Cancel

Figure 4-1 Advanced Driven Solution Setup window (General tab) for a driven modal or

a driven terminal design

If you want HFSS to quickly compute only the 2D excitation field patterns, impedances, and
propagation constants at each port, select the option Solve Ports Only. If you select the Solve
Ports Only check box, the Adaptive Solutions panel disappears from the General tab. If you clear
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the check box, the Adaptive Solutions panel gets reinstated. Some of the options appearing on
various tabs for the driven solution setup are discussed below.

General Tab
General is the first tab of the Driven Solution Setup window.

For an Auto setup, set the Auto Solver Setting to High Speed, Balanced, or Higher
Accuracy. Choose a Sweep Type of either Interpolating or Discrete Sweep. Select the
Distribution type, set parameters for frequency start and end, and add the appropriate number
of sweeps. Decide whether or not to Save Fields. If you are interested in the far field only, select
Save radiated fields only.

For an Advanced setup, use this tab to define the operating frequency for simulating your design
and specify convergence criteria for the simulation. Initially, the General tab has default values
of 5GHz for the solution frequency, 6 for the maximum number of passes and 0.02 for maximum
delta S. These fields are editable.

For either automatic or advanced setups, the General tab also allows you to open the HPC and
Analysis Options window.

The different options and fields available on the General tab for Advanced solution setups are
further described in:

« Solution Frequency Setting

» Adaptive Solutions

Solution Frequency Setting for Advanced Setups

The solution frequency is used by HFSS to determine the maximum initial tetrahedra size and is
the frequency at which HFSS explicitly solves the given model.

The solution frequency is the frequency at which HFSS performs the adaptive refinement
process, which continues until the solution converges.

The solution frequency is the frequency at which HFSS explicitly solves a given simulation. Itis
also at this frequency that the adaptive solution operates, and it is the fields at this frequency that
are used to determine whether a model has converged or not.

In general the solution frequency should be set to the operating frequency of the device being
simulated. To generate a solution across a range of frequencies, define a frequency sweep and
set the solution frequency to either the device operating frequency, the center frequency of the
sweep, or a frequency that is between 60 and 80 percent of the maximum frequency desired.
The frequency that is used depends on what type of frequency sweep will be used.
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For most antenna simulations, the solution frequency should be set to the operating frequency of
the antenna. For simulations of filters, the solution frequency should be set to the center of the
bandpass frequency.

The solution frequency is also the frequency that should be used for any calculations the user
performs when creating a model that depend on a frequency. Examples of these types of
calculations are air region size for antenna problems, skin depth calculations, PML wizard input,
etc.

Adaptive Solutions

Adaptive mesh refinement is an important feature of HFSS that automatically generates
accurate solutions. Adaptive Solutions is a panel on the General tab of the Solution Setup
window where you can set the convergence criteria of the adaptive refinement process for
solving a design. Convergence is determined by monitoring a parameter from one adaptive pass
to the next. The most common convergence criterion is to ensure that the difference in the S-
parameter value between two consecutive solves is less than the specified magnitude.

The following options exist on the Adaptive Solutions panel for a modal and terminal project:

« Maximum Number of Passes
¢ Maximum Delta S
* Use Matrix Convergence

The main control parameter used by HFSS is Delta-S to determine whether a solution has
converged or not.

Because of the direct relationship between the electromagnetic fields and the S- matrix, the
convergence of the simulation is presented to a user via the delta-S value. The value of delta-S
is the change in the magnitude of the S-parameters between two consecutive passes. Delta-S
represents the change in the electromagnetic energy between successive solutions. Once the
magnitude and phases of all S- parameters change by less than the delta-S value that you
specify, the analysis stops and is considered converged. Conversely, in electric field terms, once
the electromagnetic energy is no longer changing in the given model, the field solution has
converged and is correct. If the desired delta-S parameter is never reached, HFSS continues
until the requested number of passes is completed. The maximum delta-S is defined as

va, [mag(s -3}

where: jand j cover all matrix entries. N represents the pass number.
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Delta-S should be set between 0.005 and 0.1 for most HFSS simulations. A typical convergence
plot for Max Mag Delta S across different adaptive passes for a simulation is shown in the
following figure.

0.59

010

Max Mag. Delta 5
1

=
(=]
-
I

0.00

FPass Number

Figure 4-2 Convergence Plot for the Max Mag Delta S

The Maximum Number of Passes option is the maximum number of adaptive iterations that
HFSS can perform during a simulation. This parameter is the stopping criterion for a simulation.

The Use Matrix Convergence command allows you to define a different stopping criteria for
specific entries in the S-matrix. The adaptive mesh refinement process continues until the
magnitude and phase of the entries in the S-matrix change by an amount that is less than the
specified criteria from one adaptive pass to the next or until the requested number of passes is
completed. The Matrix Convergence Criteria include settings for all matrix entries,
diagonal/diagonal-off matrix entries, or specific individual matrix entries.

Options Tab

Options is the second tab of the Driven Solution Setup window for Advanced Solution Setups.
This tab includes settings for the initial mesh options for lambda-based refinement and adaptive
options for controlling mesh growth by the refinement per pass and the minimum number of
passes as well as the minimum number of converged passes. In addition to these settings, you
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can also specify the solution options for the type of solver and the type of Basis functions you
want to use for a particular problem.

The settings appearing on the Options tab are described below.

Initial Mesh Options

The initial mesh options panel consists of lambda refinement settings. The settings are
described below.

Lambda Refinement

The initial mesh is based on the 3D solid geometrical model only. It has no bearing on the
electrical performance of the device that is being simulated. The lambda refinement process
involves refining the initial mesh until most of the mesh elements are approximately a quarter
wavelength for air and one third wavelength for dielectrics. A wavelength is based on the single
frequency value entered in the Solution Frequency field. For almost all cases, lambda
refinement should be used. For most problems, it is recommended to accept the default values.

Use Free Space Lambda

The Use Free Space Lambda option forces the lambda refinement to target a mesh size that is
approximately one-quarter of a wavelength for air. If you select this option, the material
properties of objects are ignored. This option can be useful in applications that have dielectrics
with very high conductivities. Brain tissue or salt water are examples of materials that produce
very high mesh counts even though the RF penetration into the material is limited to a region
very close to the surface.

Adaptive Options

This panel deals with adaptive refinement settings and minimum number of adaptive passes and
converged passes. The Maximum Refinement Per Pass option is the maximum percentage of
tetrahedra that are added to the mesh in each adaptive pass. By default Minimum Number of
Passes is 1. Regardless of whether a solution reaches convergence, it will not stop unless the
minimum number of passes that you specify is completed. The option Minimum Converged
Passes causes the adaptive analysis to continue until convergence criteria is satisfied for the
number of passes that you specify in this field. The default is 1. For example if you specify 3 in
this field, the analysis runs until the convergence criteria is satisfied for at least 3 adaptive
passes.

Advanced Solution Setup Options

This panel provides the options for guiding HFSS with the type of solver and the order of basis
functions to use for solving a particular problem.
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Note: For more information see the Basis Functions in HFSS in the HFSS Technical Notes.
See also Fundamentals.

Advanced Tab

The Advanced tab contains further advanced settings for an Advanced solution setup. In most
circumstances, you should not change any of the settings on this tab. It is highly recommended
that you accept the default settings.

Initial Mesh Options (Advanced)

If you want you can reuse the last adaptive mesh of an existing source design as the initial mesh
for a target design. To do this, you can select the Import Mesh check box and enter the
appropriate settings on the Setup Link dialog box to import this solved mesh by linking the
solution setup of the source design to that of the target design. For example, this feature can be
used if you want to reuse the last adaptive mesh of a unit cell and repeat it for simulating a finite
antenna array. In this example, the unit cell is the source design and the solved final mesh of the
unit cell is reused as the initial mesh and repeated for the target design of the finite antenna
array upon linking the two designs. This approach makes efficient use of the computational
resources.

Port Options

The Port Options panel appears on the Advanced tab of the Driven Solution Setup window
when your designs include wave port excitations. Port options are the convergence criteria for
the port solver. It is recommended that you accept the default settings. Refining the mesh at the
ports causes HFSS to refine the mesh for the entire structure as well. This occurs because it
uses the port field solutions as boundary conditions when computing the full 3D solution. The
mesh for each model port is adaptively refined until it includes the minimum number of triangles.
Refinement then continues until the port field accuracy or the maximum number of triangles is
reached.

IE Solver Options

This panel contains the options of using the Auto setting, ACA solver or MLFMM Solver. If you
select Auto, HFSS picks either the ACA or MLFMM solver depending upon the characteristics
of the problem being solved. For solving a design with FEBI boundary condition, IE domains or
arrays Direct and Iterative solvers are not supported. For such problems, ACA or MLFMM
solver should be used along with the Domain Decomposition setup.
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Fields

The Save Field option is selected by default. If you are interested in the far field only, then select
the option Save radiated fields only.

Expression Cache Tab

If you want to specify additional convergence criteria by using output variables or other
expressions, click the Add button and enter the appropriate settings on the Add To Expression
Cache dialog box.

Defaults Tab

The Defaults tab allows you to save the current settings as the defaults for future solution setups
or revert the current settings to the standard setting.

Transient Solution Setup

Transient solution setup is defined for solving problems in the time domain. The settings on the
Transient Solution Setup window depend upon your choice of the driven option on the Solution
Type dialog box. If you select Network Analysis, the Transient Solution Setup includes the
Input Signal tab (shown in the following figure). For Composite Excitation, the Input Signal
tab is not present on this window. The signal settings for a composite excitation are on the
Terminal dialog box. You can launch this dialog by double-clicking the terminal associated with
a port under Excitations on the project tree. This arrangement is because for network analysis
all excitations use the same input signal. However, for composite excitation, each source
requires its own time profile. The transient solution setup for composite excitation can be
specified for modeling a device that has multiple sources/ports active simultaneously but each
port has its own distinct time profile.
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Figure 4-3 Transient Solution Setup For Network Excitations

Some of the options on the Transient Solution Setup window for both Network
Excitations and Composite Excitations are described below.

Transient Solver

This panel appears on the General tab. You can select either the Hybrid solver or the Implicit
solver depending upon the problem. The hybrid solver is based on the explicit-implicit
discontinuous Galerkin time domain method. Implicit solver uses more memory than the Hybrid
solver. If you have a graphics processing unit or GPU, you can take advantage of it to speed up
simulation. For Hybrid solver GPU acceleration is enabled. When the GPU is enabled, only the
explicit part of the hybrid solver is running and being accelerated by GPUs. GPU acceleration in
HFSS Transient has been developed for Nvidia cards and is officially supported with the Tesla
series. Nvidia Tesla are cards recommended for the best performance when using several cards
on one machine to solve either multiple variations or excitations (HPC) in parallel.

HFSS Solution Setup 4-11
Ansys Electromagnetics Suite 2025 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



An Introduction to HFSS™

Figure 4-4 Graphical Processing Unit can be enabled for Hybrid Solver

Input Signal

On the Input Signal tab you can specify the time profile for all sources in the Transient Network
analysis. The time profile specifies the pulse used to excite a transient design. You can select
either Broadband Pulse or TDR as the profile function. For Broadband pulse, define the
minimum and maximum frequencies and number of frequency points to be extracted. This type
of pulse excitation is used if you want to extract the S-parameters within a frequency range.
Depending upon your minimum and maximum frequencies the upper plot of the signal shows
the excitation of interest. The lower plot is the corresponding energy spectrum.

For Time Domain Reflectometry or TDR pulse, the time profile is specified by the rise time which
is defined as the time for a pulse signal to rise from 10% to 90% of the peak value. TDR midpoint
is the time where the input TDR is at 50% of the peak value. Selecting the Sync check box
automatically synchronize the signal midpoint and rise time such that minimum allowed midpoint
is used for a given rise time or the maximum rise time for a given midpoint. If you clear this check
box you can specify a different valid delay. TDR pulse can be used for problems where you want
to detect a fault in a transmission line such as a coaxial cable, twisted pair wire etc. or if you want
to find discontinuities in signal integrity devices like connectors, printed circuit boards etc.

For Composite excitations, the input signal specifications for exciting a source occur on the
Transient tab of the Terminal dialog box. For each port you must specify a unique time profile.
You can select Broadband pulse, harmonic, smooth pulse, or dataset options. Dataset is a
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custom time profile. For Broadband pulse in addition to the frequency settings you need to also
define the delay and the magnitude of the pulse to excite a port. For Harmonic function displayed
as a regular sine wave, define the ramped periods, frequency, delay and magnitude and for
smooth pulse, define the pulse width, delay, and magnitude.

Duration

This tab allows you define the stopping criteria for a transient simulation.

Save Fields

You must create object lists and/or face lists for which the transient fields are to be calculated.
Save Fields tab allows you to select the list that you want to save the fields for. You can define
the start time at which to save the fields, the interval, and the maximum number of samples.

Radiated Fields

On this panel you can save the radiated fields for the frequencies defined on the Input signal tab.
Suppose you define a broadband pulse of with a Min and Max frequency of 1 MHz to 200 MHz
respectively, and Frequencies extracted as 201 on the Input tab, then on the Radiated Fields
tab you can save frequency domain radiated fields for the frequency points extracted between 1
MHz to 200 MHz.

HPC and Analysis Options

High performance computing (HPC) enables a range of different technologies in HFSS that
allows efficient simulation of extremely large and complex problems. HPC leverages multiple
cores through matrix multiprocessing, distributed frequency points (called spectral
decomposition method or SDM), domain decomposition (DDM), parallel hybrid FEM/IE solving
or the finite antenna array DDM. In addition hierarchical HPC solving is possible where
frequency points can be distributed with each frequency point using multiple cores or machines
for large scale DDM analysis at each frequency point, all in parallel. HFSS intelligently
determines which jobs are to be performed and how to distribute them for the simulation. It
automatically apportions the jobs during the simulation process and makes optimum use of the
available resources. This computing technology enables generating accurate solutions for large,
complex, higher-fidelity models. For example, the following figure illustrates an HFSS solution
powered with HPC and Parametrics to solve an antenna on a helicopter launching from stern of
a ship. Automatic adaptive meshing provides mesh for each parametric instance.

HFSS Solution Setup 4-13
Ansys Electromagnetics Suite 2025 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



An Introduction to HFSS™

Efficient simulation of large, complex problems by using HPC, HFSS provides enhanced insight
that would be difficult or impossible to obtain any other way. HFSS software has these very
powerful capabilities that take advantage of multi-core and/or networked computers. These new
and enhanced features allow organizations to leverage multi-core/ multi-machine environments
and compute clusters. This ability to simulate large, time-consuming problems in a highly
efficient manner allows for further, higher-fidelity insight into a company’s design.

Domain Decomposition

A unique feature in HFSS is the Domain Decomposition Method that can efficiently and quickly
solve large scale electromagnetic problems. In DDM a large problem domain is partitioned into
small sub-domains. A large mesh is broken down into small sub-meshes, and each sub-mesh or
sub-domain is solved in a separate core or a set of shared cores. These separate cores either
reside on a single computer or can be spread across multiple computers in a network. DDM
performs the simulation by apportioning the domains across many networked computers or
different cores in a single computer. Once simulations are complete, an iterative procedure
combines the separate results into a single solution that gives the complete response for the
entire model. DDM is extremely scalable with the ability to show in some cases super linear
performance with respect to a single core analysis.

For finite periodic structure such as antenna arrays or frequency selective surface the domain
decomposition technique is further enhanced by leveraging the repeating nature of the
geometry, mesh and matrix. This results in a technique that significantly reduces the memory
requirement and simulation time while delivering a comprehensive analysis of the structure
including edge effects.
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The following figure illustrates a large and complex problem of solving an antenna and its
interactions in presence of a vehicle and an full size adult human body using Domain
Decomposition Method.

Figure 4-5 Domain Decomposition Method providing large scale electromagnetic
solution

The Maximum Number of Passes and Maximum
Refinement Per Pass

Refinement percentage and number of adaptive passes are both used in the adaptive solution
process. The refinement percentage specifies the largest number of tetrahedra that can be
subdivided per adaptive pass.

The maximum number of adaptive passes is the maximum number of times HFSS will refine the
mesh in order to try and converge to an answer.

The adaptive solution process uses the delta-S, maximum refinement per pass, and maximum
number of passes to converge to the correct answer. The delta-S and maximum number of
passes determine when HFSS will stop the adaptive solution process. If convergence is reached
before the maximum number of passes has been performed, the solution process stops. HFSS
will stop if convergence is not reached, but the maximum number of passes has been reached.
In such cases, it is recommended to increase the number of passes so that HFSS can reach
convergence.
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Frequency Sweeps

HFSS has three sweep types: the discrete sweep, the fast sweep, and the interpolating sweep.
Depending on the needs of a user, a particular sweep type may be preferred. Generally, the
solution times required for a frequency sweep type increase in the following order: fast,
interpolating, and discrete.

For solutions that require field information at only a few (less than five) discrete frequency points,
the discrete sweep can be faster than either of the other two.

For solutions that require field information discrete or fast frequency sweeps are used.

The fast sweep is useful when many frequency points are desired over a limited frequency range
and it also yields the field information. The interpolating sweep is most useful when solving
problems from DC to a high frequency; however, interpolating sweep does not provide field
information.

For both the interpolating and fast sweeps, the number of displayed frequency points is not
related to the time it takes to generate the frequency sweep results. Both of these sweeps, in
essence, generate a pole-zero transfer function, and it is the generation of this function that
requires the majority of the solution time. Once the “transfer” function has been generated, S-
parameter data is rapidly calculated.
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Figure 4-6 Edit Frequency Sweep window

If you use discrete sweep, the field solutions are generated at all the points in the specified
frequency sweep. A discrete sweep solution time is directly proportional to the number of
frequency points defined in the sweep. Discrete sweep uses the same converged mesh
obtained from the adaptive refinement process for solving all frequency points. The results
generated by using a discrete sweep are available only those specific points within the sweep.

The discrete sweep generates field solutions at specific frequency points in the desired
frequency sweep. The discrete sweep solution time is directly dependent on the number of
frequency points desired. The more frequency steps a user requests, the longer HFSS needs to
complete the frequency sweep. The explicit field solution is obtained by substituting the desired
frequencies into the matrix equation that was created during the adaptive solution process. Each
frequency solution is therefore explicitly based on the adaptive solution, and not interpolated via
a numerical method like the fast and interpolating sweeps. Arguably, therefore, the discrete
sweep is the most accurate sweep available. It, however, is also the sweep that requires the
most time to generate frequency sweep results when many frequency steps are desired.
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Unlike discrete sweep, the fast sweep generates the field solutions for arbitrary points in the
specified frequency sweep. If you use fast sweep, the solver determines the frequency points
within the defined sweep and creates a reduced order model based on the Eigen values of the
problem. The results from a fast sweep are available in arbitrary frequency points due to the
interpolating property of the reduced order model. Fast sweep is suitable for problems with sharp
resonances. Fast sweeps can accurately determine the electromagnetic behavior of a structure
even near resonances.

The fast sweep generates a full-field solution within the specified frequency range. The fast
sweep is best suited for simulations that have a number of sharp resonances. A fast sweep is
highly accurate in determining the behavior of a structure near a resonance.

The fast sweep works by using the center frequency of the sweep to create an Eigen value
problem that is used in an Adaptive Lanczos-Padé Sweep (ALPS) procedure to determine all the
field solutions in the requested frequency range.

Because the fast sweep uses the results of the adaptive process to generate the Eigen value
problem, it is efficient to set the solution frequency to be equal to the center sweep frequency
when using the fast sweep.

A key benefit of the fast sweep is that it allows a user to post-process and display fields at any
frequency and at any location within the frequency sweep.

The interpolating sweep generates a solution for the S-matrix over the defined frequency range.
The solver chooses the appropriate frequency points at which the field solution is calculated
HFSS does this by choosing appropriate frequency points at which to solve for the field solution.
HFSS continues to choose frequency points until the full sweep solution lies within a given error
tolerance.

Similar to the fast sweep the interpolating sweep also creates a reduced order model but just for
the SYZ parameters. These parameters are available at arbitrary frequencies.

The interpolating sweep is best suited for very broadband frequency sweeps. The interpolating
sweep uses less RAM than a fast sweep. A key benefit of the interpolating sweep is that it can
easily determine the frequency sweep response from DC to any desired high frequency. The
interpolating sweep, however, has only the solution frequency field data available for post-
processing. Field data for other frequencies within the interpolating sweep range are therefore
not available.

3D Fields Save Options.
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30 Fields Save Options
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With Save Fields (At Basis Freqs not selected, the default is for Auto S Matrix Only Solve.
Here, the solver automatically determines threshold of S-matrix only solve. The Manual option is
available for situations when:

. The direct solver is being used.

If S-matrix only solve has a singularity matrix, you might want to increase the manual
threshold.

. If you want faster simulation, you might want to decrease the manual threshold.

Differences between Local, Remote and DSO solutions

A Local Simulation is performed on the local computer (the user’s computer).

A Remote Simulation is one where a user does not solve a given HFSS simulation locally. The
user sends the simulation to be performed on another computer on the local network.

A DSO, or Distributed Solution Option, is a simulation where a user sends a given HFSS
simulation to be solved in parallel on a number of different computers. DSO currently works only
for single simulations that have discrete or interpolating sweeps or simulations that use one of
the Optimetrics™ features such as parametric sweeps.

Local Remote DSO
Solution Mode Solution Mode Solution Mode
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Historically, all HFSS simulations have been local simulations. However, in many enterprise
environments, there are select computers that are optimized for maximum RAM, speed, etc. The
remote solve capability allows a user to pre- and post-process a given HFSS simulation on the
local machine but also have the computationally intensive solution performed on a different,
possibly more powerful, computer.

The remote solve capability allows an engineer to still be productive on the local machine doing
other tasks, while the intensive number crunching is done on another machine.

The Distributed Solve Option is extremely beneficial for simulations that involve a large number
of discrete frequency steps, an interpolating sweep, or for performing a parametric, optimization,
statistical, or sensitivity analysis. For the cases of the discrete or interpolating sweep, the
required frequency steps are solved in parallel on a number of different computers. If, for
instance, a total of 100 discrete frequency steps are desired in a given simulation, DSO can
solve all 100 frequency points in parallel provided 100 separate processors are available. This
reduces the total simulation time by almost a factor of 100.

For the simulations involving the Optimetrics™ capabilities, the same general concept applies.
For instance, if a parametric sweep with 20 variations is desired, the DSO option can take this
parametric simulation and solve it in parallel on 20 different computers. Employing the DSO
greatly reduces the total computation time required for a parametric simulation.
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5 - HFSS Modeling GUI Basics

e "The HFSS 3D Modeling GUI" below

e "Modeling Practice in HFSS" on page 5-4

¢ "The Various Hotkeys" on page 5-6

» "Snapping to a Point" on page 5-10

» "Assigning Boundaries in the GUI" on page 5-11

* "Assigning Driven Modal Solution Excitations in the GUI" on page 5-13

» "Assigning Driven Terminal Solution Excitations in the GUI " on page 5-14
» "Assigning and Creating Materials" on page 5-16

» "Creating Variables" on page 5-19

The HFSS 3D Modeling GUI

The following illustration shows the HFSS 3D modeling graphical user interface (GUI) of the
Ansys Electronics Desktop application and some elements and windows that appear on it.
These elements, which include controls and commands, are presented in various graphical
forms, such as menus, ribbon tabs, dialog boxes, etc.

HFSS Modeling GUI Basics 5-1
Ansys Electromagnetics Suite 2025 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



An Introduction to HFSS™

Title Bar MEI;U Bar Ribbiun Tabs Hijtnry Tree Modeler Window
ronics LEskiop * W_ComDiner - esigni - L] Wg_compingr - signi - Modeler =
.nNS'FSEIecl ics Desht k3 biner - H ignt - 30 Modeler - SOLVEDS [ biner - HF550esign1 - Modeler] o X
B0 File Edt View Project Draw Modeler HFSS Tobls Window Help &%
H ot 9 unde M [P Detete purepors i"'“] % B Browse salutions
) Copy (¥ Redo 4 | \f modtRepont 0] - fie] crean Up Solutions
Save - Open  Qutput Medal Solutigh  Fields  Solution
Epaste X Delete  gagont= variabies DatsReport] Report=  Data [ meor Soluions
Dasktop View D Madel Simulation Results Automation 0 ﬂ
Poject Manager 3 55 Modd J
5 {11 wg_combiner" Al B Solids Erhfim1 , Z
5 b HessDesign. (Driventiodal)* = B vacuum ‘ i
6 ne " B waveguide 11476 6533
i voce " CrestePolydine 106565935
E Crot Banents a Cm‘rLinul 9113
0 Bourdires B Uu!imld-'lmt P
@ 88 Excitations o] “]_'1 Unite
& viednegers b Sweephlonglector hEre
g Math L, Coordinate Systems 7377 8540
B Anclyss I-’« 9 Planss 65580842
o cetal 4@ lits 730 3346
1
3 I Sneep 1BET4T
& [ Resus 488148
- Port Fiekd Disglay 3279,0554
& 3 Fied Overays 502967
M | 169539
Properies ax HOTIE
Mame | Vaue | Unt | Evalsted A 00163
Hame Setup
Eniabled v
Paszes b1
Pesrcert Refinemant |30
Dieda § 00
Solution Freq 0 GHz
Batis Order First Orther
Max Refnemert 1000000
Use Mas Pefrement [
UsABCOnPots | [ "
¢ > — |
HFSS F 3 0 500 1e+03 (mil)
Message Manager 3 § Progress b %
L] HFSSD;%MMH_MJ. et o e S5 0 e 238 = contion - HPSDesir] - S St of 10 s i e by hedn okl
Duyzay - o — 2
(1) Discrete Fracpuency sweep complete. (24347 P May 28, 201 MP1 based sobvet distibubon
(1) Nomal completion of smaion on server: Local Machine. (24347 PM May 28, 2019)
Nathing is seledted (7 ide 0 Messages ||~ Fide Progress |I

Figure 5-1 HFSS GUI

The Menu Bar is located near the top of the GUI. It consist of a group of menu commands
arranged by category such as File, Edit, Project, Draw, Modeler, HFSS, Tools, etc. The Ribbon
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contains frequently used commands arranged into Tabs of logically related functions such as
View, Draw, Model, Simulation, Results, and more. Commands for all operations in HFSS are
accessible from the items and buttons in the menus and ribbon tabs. You can also right-click in
the appropriate window or on Project Manager entries to perform desired operations.

For example, to excite a design with a wave port, select the appropriate face on the design, click
the HFSS menu, go to Excitations> Assign > and click Wave Port. This command brings up
the wave port wizard where you can enter the settings to apply the wave port excitation.

Alternatively, select the appropriate face on the design, right-click in the Modeler window, select
Assign Excitation and click Wave Port from the shortcut menu.

There are six distinct windows that can be active within the HFSS GUI:

* Project Manager
» History Tree

¢ Modeler

¢ Properties

* Message Manager
* Progress

Each of the windows serves a unique purpose during the creation and simulation of a given
HFSS design.

3D Modeler Window

On the 3D Modeler, you can create the objects to be simulated. Depending upon the type of
object you can select a basic solid, sheet, or line type from the Quick Access toolbar or from the
available commands under the Draw menu item. For example, to create a box with the grid
plane XY being active perform these simple steps:

1. Select the Draw box command from the Quick Access toolbar.

2. Click anywhere in the modeler window to create a point, drag the cursor along the XY
plane and click again to create the point diagonally opposite to the first point.

3. Drag the cursor along the Z axis and click again to create the box.

4. Select CreateBox in the History tree and edit the fields on the Properties window to
specify the coordinates, and the dimensions of the box.

Properties Window

The properties window displays the properties of an object or an option that is selected in the 3D
Modeler window, History tree, or Project Manager. For instance if you select a box object in the
3D Modeler window the Properties window displays the attributes of the box object such as its
name, material, color etc.
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Project Manager Window

The Project Manager window serves as an important command and project organization
window, helping you to manage your simulation designs and setups. All pertinent preprocessing
and solution information is displayed within this window (such as boundaries, excitations,
solution setup, frequency sweep, mesh settings, 3D components, and more). Information about
various Optimetrics setups appears here. Finally, all post-processing items, such as results
plots, field overlays, and antenna setup are also contained in the Project Manager window.

History Tree

The history tree window contains the model’s structure and grid details. History of the operations
on a geometry right from creating it, performing Boolean operations etc are recorded in this
window. It displays a number of items such as solids, sheets, lines, points, coordinate systems,
planes, Lists, 3D components etc one below the other.

Message window

The message window displays all messages pertinent to a simulation. They can be warning
messages, error messages, or messages that notify normal completion of a simulation.

Progress window

The progress window displays the progress of a given simulation being performed on the local
machine, on a remote machine, or on a distributed network of machines using the Distributed
Solve Option available with HFSS. It displays the number and information about an adaptive
pass that is running. It also displays information about a frequency sweep that is running.

Modeling Practice in HFSS

Typical modeling practice of creating and simulating a 3D model in HFSS involves the following
steps:

Create model/geometry

Assign boundaries

Assign excitations

Assign solution setup

Validate and analyze

o ok wbh =

Perform post-processing operations
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Figure 5-2 Modeling Practice in HFSS

Every HFSS simulation involves, to some degree, all six of the above steps. It is not mandatory
to follow these steps in the exact order, however, they constitute a good modeling practice.

The steps are described here.
1. Create Geometry

On the 3D Modeler, create the geometrical model that you want to analyze. The 3D modeler
in HFSS has advanced features that enable you to parameterize a structure by creating
variables and assigning values to them while defining geometric dimensions and material
properties. A parameterized structure is very useful especially, when the final dimensions are
not known or when the design needs to be modified for performance improvements.

You can also import 3D structures from mechanical drawing packages, such as
SolidWorks®, Pro/E® or AutoCAD®. However, imported structures do not retain any history
of how they were created so they will not be parameterizable upon import. You must
manually modify an imported geometry, if you want to parameterize the structure.

2. Assign Boundaries

Assign boundary conditions in the next step. Boundaries are defined on 2D (sheet) objects
specifically created for this purpose or on surfaces of 3D objects. Boundaries have a direct
impact on the generated solutions. Depending upon the problem, HFSS offers different types
of boundary conditions including Perfect E, Perfect H, Radiation, Primary, Secondary,
Impedance, Finite Conductivity, PML, Layered Impedance, Anisotropic Impedance, and
Lumped RLC.

Note: For more information about boundary conditions, see the chapter Assigning
Boundaries in HFSS in the ANSYS Electronics Desktop help.
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3. Assign Excitations

Excite the geometry by assigning excitations. Excitations are sources of electromagnetic
fields in the design. HFSS has various options to generate incident fields that interact with a
structure to produce the total fields. Some of these excitations are local sources residing
within the structure such as wave ports and voltage sources while other excitations such as
plane waves are created from local sources away from the structure. Excitations available in
HFSS include wave port, lumped port, terminal, Floquet ports, incident wave, voltage source,
current source, magnetic bias. There are several convenient rules that you can follow for
proper creation and use of excitations to obtain highly accurate results in HFSS.

Note: For more information about excitations and the guidelines for defining them, see the
chapter Assigning Excitations for HFSS in the Ansys Electronics Desktop help.

4. Assign Solution Setup

The next step is to create a solution setup. In this step, specify a solution frequency, the
desired convergence criteria which include the maximum number of adaptive passes and the
magnitude of maximum delta S. To generate a solution across a range of frequencies, define
a frequency sweep.

5. Validate and Analyze

After performing the above four steps, the model can be validated and then analyzed if it
passes the validation check. The time required for an analysis depends upon the model
geometry, the solution frequency, and available computer resources. HFSS also comes with
advanced High Performance Computing capability for accelerated performance and for
solving large problems.

6. Post Processing

Perform post processing once the simulation runs to completion. Any field quantity or S,Y,Z
parameter can be plotted in the post-processor. Additionally, if a parameterized model has
been analyzed, families of curves can be created. For example, you can examine the S-
parameters of the device modeled, far fields created by an antenna, or plot the
electromagnetic fields in and around the structure.

The Various Hotkeys

A hotkey is a specific key, or combination of keys, that you can press to perform a task more
quickly than by using the mouse. For example, if you want to fit the extents of a model within the
3D Modeler window, simply press Ctrl + D. This hotkey combination is quicker than navigating
the View menu or locating a command on a ribbon tab, especially if your hands are already on
the keyboard.
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Common hot keys, often in conjunction with a mouse button, are used to perform pan, rotate,
and zoom operations. Additionally, you can use hotkeys to produce standard planar (XY, YZ,
XZ) and isometric views of geometry in the modeling window.

To pan the view, press Ctrl + middle-click and drag the mouse. Alternatively, if the Enable
Legacy View Navigation option is selected in the User Interface Options, you can also press
Shift + left-click and drag to pan the view.

To rotate the view press midle-click and drag the mouse. Alternatively, if the Enable Legacy
View Navigation option is selected in the User Interface Options, you can also press Alt + left-
click to rotate the view.

To zoom the view, middle-click and drag the mouse upward (zoom in) or downward (zoom out).
Alternatively, if the Enable Legacy View Navigation option is selected in the User Interface
Options, you can also press Alt + Shift + left-click and drag upward/downward to zoom the
view in/out.

Holding down the Alt key while double-clicking the left mouse button orients the view in the
Modeler window as shown in the figure below. The resulting view orientation depends on which
of the nine zones the cursor occupies when you double-click. Each cube in the figure represents
a clicking zone and shows the resulting view orientation:
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There is no Alt + double-click zone associated with the standard Back, Dimetric, or Trimetric
view orientations. These three views must be selected from available menu or ribbon
commands.

There are a number of additional hotkeys. They are broken down into two groups: General
Hotkeys and 3D Modeler Hotkeys, which are discussed in the next two topics.

General Hotkeys

F1 Help (context-sensitive)

F2 Rename an item in the Project Mmanager window.
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F4 + CTRL | Close Modeler
CTRL+C | Copy
CTRL+N | New Project
CTRL+ O | Open
CTRL+S | Save
CTRL+P | Print
CTRL+V | Paste
CTRL+ X | Cut
CTRL+Y |Redo
CTRL+Z |Undo
CTRL+0 | Cascade windows
CTRL+1 | Tile windows horizontally
CTRL +2 | Tile windows vertically
3D Modeler Hotkeys
B Select face/object behind current selection
F Face selection mode
0] Object selection mode
E Edge selection mode
Vv Vertex selection mode
u Sub model selection mode
M Multi-selection mode (for example, to select an edge and a vertex)
CTRL+A Select all visible objects
CTRL+ SHIFT + A Deselect all objects
CTRL+D Fit view
SHIFT + Middle Pan the view
Mouse Button
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SHIFT + Left Mouse
Button

Pan the view

This combination only works if the Use Legacy View Navigation option
is selected in the User Interface Options.

CTRL + arrow-keys

Pan the view vertically or horizontally. Each press of an arrow key pans
the view 10 screen pixels.

Middle Mouse Button

Rotate the view

ALT + arrow-keys

Rotate the view about a vertical or horizontal axis. Each press of an
arrow key rotates the view 2.5°

Rotate the view

Mouse Button

ALT + Left Mouse , L , . L .

Button This combination only works if the Use Legacy View Navigation option
is selected in the User Interface Options.

CTRL +"+" Zoom in, screen center

CTRL +"-" Zoom out, screen center

SHIFT + Middle

Zoom in/out — drag upward to zoom in and downward to zoom out

ALT + SHIFT + Left
Mouse Button

Zoom in/out — drag upward to zoom in and downward to zoom out

This combination only works if the Use Legacy View Navigation option
is selected in the User Interface Options.

F3 Switch to point entry mode (that is, draw objects by mouse)
E4 Switch to dialog entry mode
(that is, draw object solely by entry in command and attributes box)
F6 Render model wire frame
F7 Render model smooth shaded

Snapping to a Point

The HFSS modeling Ul employs a visual feedback system that allows you to “snap” to a
particular location on an object. The cursor changes shape when it is moved over a specific
location, thus indicating that any drawing object created will be snapped to that specific location.

HFSS Modeling GUI Basics 5-10
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Vertex Face Center AIT CEJ“E!‘_
snap \ snap (circle) Snap (3/4 circle)

Grid E Lge C Em“.\ Edge Quadrant

point snap  snap (triangle) 3P (Pie)
{diamond)

Figure 5-3 Simple 3D object showing various “snap” locations and the location-specific
icon.

By default, the selection point and graphical objects are set to “snap to,” or adhere to, a point on
the grid when the cursor hovers over it. The coordinates of this point are used, rather than the
exact location of the mouse. The cursor changes to the shape of the snap mode when itis being
shapped.

The cursor in the HFSS modeling Ul is usually a small diamond. However, the diamond shape
changes into a circle, triangle, pie slice, or rectangle, depending on whether the cursor is moved
into close proximity with a face center, mid edge, quarter edge, or corner vertex, respectively.
Once the cursor has changed shape, a drawing object is “snapped” to the location that
corresponds to the cursor shape. For example, if you want to draw a cylinder that is centered on
a face of a cube, simply move the cursor over the center of the face until the cursor changes to a
circle. Once it has changed shape to a circle, click to set the start location of the cylinder and the
cylinder center will be snapped to the center of the cube face.

You can follow the above procedure and snap to any convenient point when creating any model
objects.

Snap locations can be activated and deactivated at your discretion. To do this, a user can simply
select which snap to have active by selecting the appropriate icon. Alternatively, a user can vary
the snap selection by selecting modeler in the tool bar and choosing snap mode.

Assigning Boundaries in the GUI

Boundaries are assigned to 2D object in a model or on the surfaces of 3D objects.

HFSS Modeling GUI Basics 5-11
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Figure 5-4 Perfect E Boundary assignment

To assign a boundary to a 2D object or 3D face, press the F key to enter face selection mode
and select the appropriate 2D object or 3D face. Once all the desired faces have been selected,
simply right-click and select Assign Boundary. Finally, select the desired boundary.
Alternatively, once all the faces have been selected, a user can click the menu item HFSS near
the top and go to Boundaries> Assign > and select the desired boundary.

Note: If you want to assign a common boundary to multiple faces, first select the multiple faces
by holding the CTRL key and in the same way assign the boundary.
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Assigning Driven Modal Solution Excitations in the GUI

Excitations are assigned to 2D object in an HFSS model or on the surfaces of 3D objects. You
can assign appropriate excitations on a design based on the solution type. The steps for
assigning wave ports for a driven modal project are shown below.

1. Select face(s) _f]:‘—————___

" , - —
Sebect Obgecty o A Am— —_—
v SeectPaces P - ——
Sebect Edges i . 4
Sedect Vertsces L
Sebect Mult 1]

@ Al Object Faces

2. Right-click,

Assign Excitation
> Wave Port

it ot L

Ect ¥

Creste 10 Component

Create Open Regeon
Update Open Regon Padding.

Asasgn Boundary ]
Asugn Escdation ’ Waree Port
Asisgn Hybind ¥ Lumped Port...
Asugn Mesh Operstion ’ Floguet Pert_
Plot Fields '
Incident Wave k
Plot Mesh Lisked Fatld ¥
Copy bmage Veltage_.
Currend_,
Iagnets: Baas...

Figure 5-5 Wave Port assignment for a modal project

To assign an excitation to a 2D object or 3D face, press F to enter face selection mode and
select the appropriate 2D object or 3D face. Multiple faces can be selected if a common
excitation is to be applied to them. Once all the desired faces have been selected, right-click and
go to select Assign Excitation and click the desired excitation from the submenu. Alternatively,
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select all the faces and click the HFSS menu item on the menu bar near the top, and go to
Excitations > Assign > and click the desired excitation on the submenu.

A user should ensure that the port area is of the proper dimension. For reference, see the
section on ports. While it is not necessary to create an integration line when creating a wave
port, itis good modeling practice and is, therefore, strongly encouraged.

Assigning Driven Terminal Solution Excitations in the GUI

Excitations are assigned to specifically created 2D object in an HFSS model or to specific faces
of 3D objects. To assign an excitation to a 2D object or 3D face, simply change to the select
faces mode and select the appropriate 2D object or 3D face. Multiple faces can be selected if a
common excitation is to be applied to them. Once all the desired faces have been selected,
right-click, select Assign Excitations, and choose the desired excitation. Alternatively, once all
the faces have been selected, you can click on HFSS in the top-level menu bar, select
excitations, choose assign, and select the desired excitation.
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Figure 5-6 Terminal Solution Excitations on a Connector
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HFSS can automatically associate terminals with the ports whether you assign the ports first and
then define the terminals or vice versa. You can define terminals from the Excitations level (in

the Project Manager window) when the ports already exist. Regardless of the order in which they
are assigned, a terminal is associated with the port containing the signal and reference

conductors that define the terminal.

Assigning and Creating Materials

All 3D objects in HFSS must have a material property assigned to them. Objects are assigned a
default material during the 3D object creation process. The material assigned to a given object
can be changed at any time after the object is created.

L. Select object

2. Select Assign Material

Edet
Create 3D Compon
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3. Specify Material from the database

Figure 5-7 Material Assignment process

You can also define or change the material property of an object, from the Edit Libraries
window. To bring up this window, go to the Tools menu and select the Edit Libraries >
Materials. Select the material from the database and click OK to assign the desired material on

the object.
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There are other methods to assign materials. After you create an object the Properties window
appears. The Properties window is also docked with the Project Manager window. Upon
creation of a new object, go to the Attribute tab on the Properties window. From the Materials
drop-down menu select Edit and open the Select Definition window and specify the desired
material from the database.

If you double-click the object name in the command history tree, the Attribute dialog box appears
where you can change the material.

If a particular material is not found in the default HFSS material database, a custom material can
be created. Frequency-dependent material can also be created if needed.

To add a material to the database, simply access the materials database and click on the Add
Material button at the bottom of the dialog box. Simply enter a name along with the desired
material properties and close the dialog by clicking OK. The created material is automatically
assigned to the 3D object.

Frequency-dependent materials can be based on four distinct definitions: Piecewise-linear,
Debye, Djordjevic-Sarkar, or as a collection of data points. Each method creates a material that
has specific material properties as a function of frequency.

The Piecewise Linear and Frequency-Dependent Data Points models apply to both the electric
and magnetic properties of the material. However, they do not guarantee that the material
satisfies causality conditions, and so they should be used only for frequency-domain
applications.
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Figure 5-8 Custom material creation

The Piecewise linear model defines a material that has three distinct regions. The first region
has a flat constant dielectric property, the second has a linear slope, and the last section is flat
again. You can specify the break frequencies between sections one and two and sections two
and three.

The Debye and Djordjevic-Sarkar models apply only to the electrical properties of dielectric
materials. These models satisfy the Kramers-Kronig conditions for causality, and are preferred
for applications where HFSS results, both S-parameter and equivalent circuit, will be used in a
time-domain simulation.

HFSS Modeling GUI Basics 5-18
Ansys Electromagnetics Suite 2025 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



An Introduction to HFSS™

The Debye model is a single pole model for the frequency dependency of a lossy dielectric. You
can specify the two frequencies along with the dielectric constant and loss tangent at those
frequencies. If desired, you can also specify the permittivity at an optical frequency and DC
conductivity and constant relative perme- ability.

For the Djordjevic-Sarkar model, you can specify the permittivity and loss tangent at a single
frequency. Additionally, you may enter the conductivity and permittivity at DC. This model was
specifically developed for materials that are commonly used in printed circuit board and package
designs.

Creating Variables

You can create variables for any dimensional or material property, or output value. Variables can
be Design variables or Project variables. Once a variable has been created, parametric sweeps,
optimization, sensitivity and statistical analysis can be performed.

Properties X
Name | Value Unt Evalusted Value | Type
cl2 cl m_per_sec  299792458m_per sec  Design
freq_MH:z 2000 2000 Desion
resH res_ad"c0/freq_MHz"4*1E6) 0.02810554 29375 Diessgn
resH_in resH™39 3707in 1.106518006003 7in Diesigry
D 12 [ :
—— Add Variable
b 15
baxY 325 Mame [rﬂ |
turinglL ] 0.05 |
TapPt_In 045 Uni Type |Length =
cavH 14 Uit |m-‘n :J |
res_adj E.-. |

WValue 0n7s

Figure 5-9 Variable Creation
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When you specify a variable in the Properties window for a particular dimension the Add
Variable dialog appears. In this dialog you can define the Value, Unit, and the Unit Type for the
variable.

You can also define variable as you create the object. For example, suppose you want to create
a box and variables for the length, breadth, and height of the box. To do this, enter the variable
name for the different dimensions. For each variable name you enter, the Add Variable dialog
box appears prompting you to specify a value for the defined variable.

There are two types of variables in HFSS: design variables and project variables. Project
variables can be assigned to any parameter value within the HFSS project where it was created.
By contrast, design variables can be assigned only to a parameter value within the design where
it was created. A project may contain many designs, so depending on how often a variable is
used and where you can determine what type of variable to use.

Regardless of the type of variable, it always represents a numerical value, mathematical
expression, or mathematical function that can be assigned to a design parameter in HFSS.
Variables are very useful in situations where a parameter value is changed often, if it is desired
to perform a parametric analysis, perform an optimization, or intend to create an output variable
to which HFSS is desired to converge to.
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6 - HFSS Post-Processing

e "Plotting S-parameter results" below

» "Exporting Touchstone Files" on page 6-3
« "Advanced Plotting of Results" on page 6-5
« "Plotting Antenna Results" on page 6-6

¢ "Plotting Field Results" on page 6-8

+ "Creating Animations" on page 6-10

Plotting S-parameter results

One of the most important outputs from HFSS is the S-parameter. Once a simulation has
finished, S-parameters can be plotted at a single frequency or over a frequency sweep.
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Figure 6-1 Creation of S-parameter plots

To create an S-parameter plot, right-click Reports on the Project manager window and select

the option Create Modal Solution Data Report > Rectangular Plot. This command opens the
Report dialog box. Select the desired Solution under the Context panel and then from the
Category, Quantity, and Function panels, select the S-data to be plotted.

HFSS generates S-parameters with matched loads. Matched load essentially means that the
port is loaded by its characteristic portimpedance. S-parameters of the matched loads can be

renormalized by loading the ports with arbitrary impedance. When comparing HFSS wave port
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results to measured data, it is important to re-normalize the HFSS results to the loading
impedances when the measurement was performed. If a given S-parameter is based on a
lumped port, the S-parameters are normalized to the value of Zo specified when the port was
created.

Exporting Touchstone Files

HFSS allows exportation of any of the quantities that it calculates in touchstone format.A
common use of exported touchstone files is in circuit simulators. Touchstone files are easily
exported by following the steps.
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Figure 6-2 Exporting Touchstone Files

The steps for exporting matrix data in touchstone format is straightforward. Right-click Results
from the Project Manager window and select Solution Data from the shortcut menu. This
command opens the Solution Data window. Next, select the Matrix Data tab and the Export
subtab. Finally, Click Export Matrix Data. This button lets you export the calculated quantities in
touchstone format. Browse to your desired folder to save the file in touchstone format.
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Advanced Plotting of Results

In addition to S-parameters, HFSS can plot a number of additional quantities of interest in
RF/microwave/SI design using the Results Editor. A partial list of these quantities include
gamma information, Y and Z parameters, TDR results, VSWR data, and Group Delay.
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slﬂlll-ltiﬁl"ll Setupl : Sw WE
| e o1 ﬂ Primary Swesp: |Freq ll |Al| _]
Domain: !
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v Real time I Epsilon T {lallel
Qutput Variables... | Options... | MNew Report | | Close

Figure 6-3 Report dialog box
Some of the options appearing on the Results dialog box are described below.

Domain: Plot time-domain responses for a given simulation model by selecting TIME as the
sweep variable in the drop-down dialog in the upper left of the New Report dialog box. Once the
TIME variable has been selected, the TDR options button becomes active and a user can
choose to plot a time-based system response such as a TDR plot.

Families: For a parametric sweep, the data families are available to be plotted if you select the
Families tab in the top center of the New Report dialog box. The Families tab allows you to
access parametric data.

Output Variables: To generate mathematically based output quantities, select the Output
Variables button. The standard output quantities can be enhanced by creating output variables
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based on mathematical expressions. These output variables can be created by clicking on the
Output Variables button in the lower right-hand corner of the New Report Dialog.

Category: Select the appropriate Category depending upon the quantity of interest that you
want to plot.

Function: This option allows you to choose a proper function type for your quantity. For
example, you can select dB for plotting S-parameters.

Note: Reports can also be generated by clicking HFSS in the menu bar, selecting results, and
selecting create modal (or terminal) reports. In the new report dialog box, you can specify what
data is to be plotted (as shown above).

Plotting Antenna Results

Far field antenna patterns are easily generated by HFSS using the Reports Editor. The
procedure is similar to plotting the standard circuit parameters. But the model should include
either Radiation or PML boundaries, and a Far Field Setup must be defined before Far Field
quantities can be plotted.
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Figure 6-4 Far field radiation sphere setup

The specified far field radiation sphere setup is selected from the Geometry drop down menu of

the Report dialog box. This report dialog box is generated by right-clicking Results in the
Project Manager window and selecting Create Far Fields Report > Radiation Pattern.
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Figure 6-5 Creation of Far Fields Radiation pattern

When HFSS generates far field data, the field values on the radiation surfaces are used to
compute the fields in the space surrounding the modeled structure, outside of the solution
volume. This space is broken down into the near field and far field regions, where the near field
is the region close to the solution volume.

Plotting Field Results

HFSS can produce a plot of any standard electromagnetic quantity, such as the electric field,
magnetic field, Poynting vector, or current density. Generally, fields are displayed on 2D obijects,
faces of 3D objects, or on coordinate system planes. Plots can be scalar quantity plots or vector
quantity plots.
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Specific quantities based on mathematical operations on the basic field quantities can also be
plotted by use of the fields calculator.

Figure 6-6 Example of an E-field plot on the XZ plane of a pillbox antenna

Field plots or, more specifically, field overlays, are representations of the basic or derived field
quantities on specific surfaces of objects or within an object for the current design variation.

A field overlay’s appearance can be changed by modifying the settings in the Plot attributes
dialog box. This dialog modifies a plot folder and all field overlays contained within that folder will
use the same attributes.

Field overlays can also be created by the use of the field calculator. The field calculator allows
you to create mathematical operations on the basic field quantities. These results can be plotted
or exported depending upon your needs. Once a mathematical operation has been created in
the calculator, it can be added to the Named Expressions stack. After adding, this quantity can
be plotted by selecting Plot Fields > Named Expressions dialog.

Alternatively, you can simply right-click in the modeler window, and select Copy Image. This
operation places the contents of the window into the “clipboard,” and you can paste the field
overlay into a document such as Word or PowerPoint.
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Creating Animations

HFSS allows the animation of any field overlay plot. Field overlays can be animated with respect
to excitation phase or any other variable that is part of the HFSS design, including user-created
variables.

Only existing field overlays can be animated.

=Ty Field Overlays

=P EReld
Yo El

EI? Radiation Rename

i B notes X Delete

_] Definitions
Medify Plot...
Set Context To Active Window
Export Plot...
Animate...
Plat Visibility
Reassign
Select Assignment

An animated plot is a series of frames that displays a field, mesh, or geometry at varying values.
To create an animated plot, you can specify the values of the plot that you want to include. Each
value is a frame in the animation. You can specify the number of frames to include in the
animation.
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7 - Component Modeling

+ "3D Components" below
+ "3D Components Workflow" below

3D Components

In HFSS, you can create 3-D components and integrate them into larger assemblies. HFSS 3-D
components also comes with optional encryption and password protection features that allow
component creators to control their access and use.

This 3D component modeling approach facilitates the creation of large communications
systems, and becomes especially useful as these systems become more and more complex.
Consider the creation of an aircraft communication system in which a number of blade antennas
operate on a single helicopter. The component modeling approach enables the antenna
engineer to create the blade antenna once and turn it into a 3D component. They can also create
copies of this component in order to make them shareable with the system integrator. For the
system integrator it is very efficient and convenient if these blade antennas exist as 3D
components so that they can simply add these simulation-ready components onto the helicopter
body. If the creator of the antenna chose to protect their model by encryption, a password or an
internal key is needed; when the blade antennas are placed on the body of the helicopter the end
user needs the password or the internal key to place the component on the model and run the
simulation.

This results in an accurate, fully coupled 3-D simulation that accurately characterizes the
antenna performance in the context of the entire communication system.

This component design flow saves time and effort since you only need to create a component
once, and then can make it available for use while designing several different communication
systems. It also enhances collaboration among engineers and allows each to focus on their area
of expertise thereby improving workforce productivity.

Simulation-ready 3-D components can be created and stored in library files that can be simply
added to larger system designs without the need to apply excitations, boundary conditions and
material properties. All these internal details are already incorporated in the original design of the
3-D components.

3D Components Workflow

This section describes the typical workflow involved in creating a 3D Component, hiding the
internal details of the component, encrypting the component and then adding it to a target
design. To illustrate the workflow, a blade antenna design is used. The blade antenna is turned
into a 3D component and placed on the top of a helicopter model. The process of creating the 3D
component and integrating it to a larger assembly is described below.
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» Press the O key to enter object selection mode in HFSS, and select the entire antenna.

* Right-click and select the Create 3D Component option from the sub-menu. This
command brings up the Create 3D Component dialog box which contains the following
tabs: Info, Model, Boundaries, Excitations, Mesh Operations, Coordinate Systems,
Parameters, Encryption, Hybrid Regions, and Image.

* The Info tab is populated with the default component name (in this case, Blade
Antenna), its owner, date, and other details. The fields appearing on the Info tab are
editable. You can enter text in the Notes field if needed; if you want you can also enter
your organization’s name in the Company field.

 If you want to display your company logo when the component is used, select the check
box Display image in 3D modeler window whenever this component is used, and
click the Browse button to locate the appropriate graphic and include it.

« All properties of the blade antenna are encapsulated in the component. The properties on
the various tabs cannot be modified directly in the target design. However, you can define
parameters in the component. The user of the component can modify these parameters in
the target design. If the creator of the component edits its properties and saves the
changes, the user of the component has the option to update the instance in the target
design.

« The Image tab gives the preview of the 3D component that the user will see when
selecting the component.

« 3D components also come with the encryption and password protection features that
allow the user of the component to control their access and use. These features are
optional.
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m Create 30 Component

[+ Encrypt File Set Password...

" Show Al Cortents

(+ Hide Selected Contents ~ Hide/Show Objects

|+ Replace Object and Material Names

Component Outline
{* Bounding Box

" Mone
Securty Message:

This message is shown to user of the component at the time of insert and
also every time project containing encrypted component is opened.

Mesh Operations ] Coordinate Systems ] Parameters Encryption M
Irfi ] Model ] Boundaries ] Excitations Hybrid Regions ]

Ok Cancel

Figure 7-1 Encryption tab of the Create 3D Component dialog box

« Another important feature is that the creator of the component can also hide its internal
details. By default all objects of the 3D component are hidden. You can select the objects
that you want to hide from the user of the component. Depending upon your preference
you can also make all or some of the objects in the component visible. For example, you
can make the component outline visible along with some geometry details to help the user
of the component with its placement and the post processing operations. The objects that
you want to hide or make visible in the target design can be specified in the Model tab.

¢ To encrypt the component you can configure a user password or an internal key.
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» After you specify the various options accordingly on the Create 3D Component dialog
box, clicking OK brings up the Export File window.

* You can store the component in any location. UserLib or PersonalLib directories are also
provided for storing the components. The first 3D Component that you save in one of
these directories generates a folder named 3D Component under that directory. These
UserLib and PersonaLib locations are for any libraries of definitions including materials,
circuit components, and 3D components. Their usage is based on convention. Userlib is a
central library in the installation directory that is meant to be shared by multiple users
whereas Personalib, located in the project directory, is meant to be used by individual
users. For this example, store the component in the UserLib so that the blade antenna can
be shared with many users.

r - - EE A
m Create 30 Set Passwords %
v Ency ™ with User Pazeword  ©* With Internal Key
|
v |
I Allow Component Edit
{* Mever " With User Password
Seci
This
also oK | Cancel
L -
Mesh Operations ] Coordinate Systems ] Parameters Encryption m
Irfo J Maodel ] Boundaries ] Excitations Hybrid Regions ]
QK Cancel

Figure 7-2 Encrypt the component by configuring a password or internal key

Component Modeling 7-4
Ansys Electromagnetics Suite 2025 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



An Introduction to HFSS™

At this point the 3D component with hidden content is created and becomes shareable
with the user or the system integrator who can add the component to the target design.

To add the component, right-click 3D Components option on the Project Tree and from
the sub-menus select Insert Instance > UserLib > Blade Antenna. Since the
component is stored in UserLib, it appears as a selection.

Note: Blade Antenna is the default component name.

If the 3D component was encrypted, an internal key or user password is required
depending upon the type of protection configured by the creator.

The Insert 3D Component dialog box appears. The Image tab accordingly hides the
internal details as specified by the creator of the component. If you define the correct
coordinate system for the placement of the component on the platform and click OK, the
3D component is added to the target design at the appropriate location.

In this example, the blade antenna component gets placed on the top of the helicopter
body.

The system is now ready for simulation. The antenna details remain encapsulated in the
3D component and do not become a part of the helicopter model, but they are passed to
the solver for simulation. This results in an accurate, fully coupled, 3D simulation of the
entire system. Fields from the antenna induce currents on the helicopter body, and
reflected fields from the helicopter may also interfere with the antenna performance.
HFSS uses efficient hybrid simulation techniques to efficiently model the interaction
between the structures, and to apply the appropriate solution methods to each.

3d component of a
blade antenna that1s |
mtegrated mto a large
assembly, in this case,
a helicopter.
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Figure 7-3 3D simulation of the entire system after Blade Antenna 3D component is
added on the top of a helicopter body
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